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Thank you for choosing Epiphan!
At Epiphan, product function and quality are our top priority. We make every 
effort to make sure that our products exceed our customers expectations. We 
regularly contact our customers to ensure product performance and reliability. 
We strive to continually enhance our products to accommodate your needs.

Specifications
Epiphan manufactures a wide range of VGA and DVI Frame Grabbers. You can 
go to the Frame Grabbers page of the Epiphan website and use the information 
in the comparison table to select the optimal Frame Grabber for your 
requirements.

Warranty
All Epiphan Systems products are provided with a 100% replacement warranty 
for one year from the date of purchase. We welcome your feedback and 
suggestions for product improvements. You can email your comments to 
info@epiphan.com.

Technical Support
Epiphan is staffed by a professional support team. If, after checking the FAQs 
for your product on the Epiphan website and re-installing the Epiphan driver 
software, you continue to have outstanding issues, email a problem report to 
support@epiphan.com. To help us solve the problem efficiently, include the 
following info:
• Your hardware platform and operating system.
• Your product serial number
• The version of the Video capture application and the USB driver that you 

are using.
• The behavior of your Frame Grabber product LED indicators.
• Technical description of the VGA or DVI signal source including resolution, 

refresh rate, synchronization, type of hardware.
• Complete description of the problem you’re experiencing. If possible please 

provide screen captures that show the problem.
Environmental Information
The equipment that you bought has required the extraction and use of natural 
resources for its production. It may contain hazardous substances that could 
impact health and the environment.
In order to avoid the dissemination of those substances in our environment and 
to diminish the pressure on the natural resources, we encourage you to use the 
appropriate take-back systems. Those systems will reuse or recycle most of the 
materials of your end life equipment in a sound way.
The crossed-out wheeled bin symbol invites you to use those systems.
If you need more information about collection, reuse and recycling systems, 
please contact your local or regional waste administration.
You can also contact us for more information on the environmental 
performance of our products.

Copyright © 2009 Epiphan Systems Inc.
The names of actual companies and products mentioned herein may be the trademarks 
of their respective owners.
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1. Introduction
Epiphan Frame Grabbers are compact external devices that you 
can use to capture video images from virtually any VGA or DVI 
source. Some example VGA or DVI sources include personal 
computers running any version of Windows, Mac OS X, or Linux, 
embedded imaging systems, medical imaging systems, scientific 
equipment, and more. 

Using the Epiphan video capture application installed on a video 
capture workstation, you can display, record, and print captured 
images and broadcast captured images on the Internet.

Epiphan Frame Grabbers can be used in a wide range of 
applications such as:

• Capturing data from a computer screen for educational, 
training and diagnostic purposes.

• Capturing and recording data from security cameras 
especially high resolution cameras equipped with VGA signal 
output.

• Monitoring remote equipment.
• Recording and analyzing data from research and diagnostic 

equipment.
• Recording and transmitting data from medical equipment for 

remote diagnoses and emergency help services when medical 
personnel cannot travel to the patient.

• Quality control and testing.
• Collaborative work.

Comparing Epiphan Frame Grabbers
Epiphan Systems manufactures a wide range of VGA frame 
grabbers. If you need to capture images from a VGA stream you 
can use Figure 1 to help select the optimal VGA Frame Grabber 
for your task. 
ser Guide Page 7
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Figure 1: Comparing Epiphan VGA Frame Grabbers

The VGA Frame Grabber comparison table on the Epiphan VGA 
Frame Grabbers web page provides more detailed comparisons of 
all Epiphan Frame Grabbers.

If you need to capture images from a DVI stream you can use 
Figure 2 to help select the optimal DVI Frame Grabber for your 
task. 

Figure 2: Comparing Epiphan DVI Frame Grabbers

The DVI Frame Grabber comparison table on the Epiphan DVI 
Frame Grabbers web page provides more detailed comparisons of 
all Epiphan Frame Grabbers.
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About this Document
This Epiphan Frame Grabber User Guide describes the basics of how 
to install Epiphan Frame Grabbers and how to use the Epiphan 
video capture application to capture, record, and broadcast 
images captured by any Epiphan Frame Grabber.

This Epiphan Frame Grabber User Guide describes version 3.30.2 of 
the Epiphan video capture application. Most of the information in 
this document describes the Windows 2000, XP, and Vista 
version; however, this document does contain sections and 
chapters about the Mac OS X version and most of the information 
can be applied to the Linux version.

This document contains the following chapters:

• Chapter 2. “System Requirements” on page 11, describes 
hardware and software requirements required to support 
Epiphan Frame Grabbers.

• Chapter 3. “Installing the Windows VGA2USB/DVI2USB 
drivers and application” on page 12, describes how to install 
the Windows VGA2USB/DVI2USB Epiphan device driver 
and video capture application.

• Chapter 4. “Installing the Mac OS X VGA2USB/DVI2USB 
drivers and application” on page 14, describes how to the 
install the Mac OS X VGA2USB/DVI2USB Epiphan drivers 
and video capture application.

• Chapter 5. “Connecting a VGA2USB Device” on page 16, 
describes how to connect a VGA2USB, VGA2USB LR, 
VGA2USB HR, or VGA2USB Pro Frame Grabber to a VGA 
source and to a video capture workstation.

• Chapter 6. “Connecting a DVI2USB Device” on page 18, 
describes how to connect a DVI 2USB Frame Grabber to a DVI 
source and to a video capture workstation.

• Chapter 7. “Connecting a DVI2USB Solo Device” on page 20, 
describes how to connect a DVI 2USB Solo Frame Grabber to a 
DVI source and to a video capture workstation.
ser Guide Page 9
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• Chapter 8. “Connecting a DVI2USB Duo Device” on page 22, 
describes how to connect a DVI 2USB Duo Frame Grabber to a 
DVI source and to a video capture workstation.

• Chapter 9. “Connecting a KVM2USB Device” on page 24, 
describes how to connect a KVM2USB Frame Grabber to a 
headless server and to a video capture workstation.

• Chapter 10. “Troubleshooting” on page 26, describes 
troubleshooting a Frame Grabber installation.

• Chapter 11. “About Epiphan frame grabbing technology” on 
page 29, describes how the components required for 
capturing, displaying, recording, and broadcasting images 
from a VGA or DVI source with an Epiphan Frame Grabber 
work together.

• Chapter 12. “Windows video capture application” on page 51, 
describes the most commonly used functions and features of 
the Epiphan Windows video capture application.

• Chapter 13. “Mac OS X video capture application” on page 79, 
describes the most commonly used functions and features of 
the Epiphan Mac OS X video capture application.

• Chapter 14. “Recording image files” on page 91, describes 
how to record the frames captured by your Frame Grabber as 
individual image files.

• Chapter 15. “Recording videos” on page 97, describes how to 
record the frames captured by your Frame Grabber as an AVI 
video file.

• Chapter 16. “Web Broadcasting” on page 121, describes how 
to share or broadcast the images captured by your Epiphan 
Frame Grabber over the Internet.

• Chapter 17. “Using the KVM2USB Frame Grabber” on 
page 129, describes using the KVM2USB Frame Grabber to 
connect to and operate a server that normally operates 
without a keyboard, monitor, and mouse.

• Chapter 18. “Advanced topics” on page 133, describes special 
topics such as upgrading to a new version of the video capture 
application, EDID, and configuring image adjustments.
age 10 Epiphan Frame Grabber
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2. System Requirements
To get started, make sure your system meets the following 
hardware and software requirements:

Hardware Requirements

Video capture workstation

Software Requirements

Video source Any VESA-compatible VGA or DVI source.

Processor speed VGA/DVI/KVM2USB: 700 MHz.

VGA2USB LR/HR/Pro, DVI2USB 
Solo/Duo: 2.66 GHz.

USB port One USB 2.0 (also supports USB 1.1)

RAM memory VGA/DVI/KVM2USB: 256 MB

VGA2USB LR/HR/Pro, DVI2USB 
Solo/Duo: 256 MB DDR2

Hard disk space 5 MB

Video 
capture 
workstation 
operating 
system

Windows 2000 SP4, XP SP2, or 32-bit and 64-bit 
Vista. See “Installing the Windows 
VGA2USB/DVI2USB drivers and application” 
on page 12.

Mac OS X 10.3 “Panther” or more recent, see 
“Installing the Mac OS X VGA2USB/DVI2USB 
drivers and application” on page 14.

Linux 2.6.x (i686 and x86_64). 

VGA2USB/ 
DVI2USB/ 
drivers and 
application

To download the latest version, browse to 
http://www.epiphan.com/products/ and 
locate the Downloads page for your product. 
(Also includes Linux install instructions.)

http://www.epiphan.com/products/
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3. Installing the Windows 
VGA2USB/DVI2USB drivers and 
application

You must install the VGA2USB/DVI2USB drivers and 
application on your Windows video capture workstation before 
connecting the Frame Grabber to the workstation USB port. This 
single download includes the video capture application and 
VGA2USB/DVI2USB USB device drivers. 

To install the VGA2USB/DVI2USB drivers and application

1 Download the latest software release to your video capture 
workstation. Browse to http://www.epiphan.com/products/ 
and go to the Download page for your Frame Grabber.

2 Download the latest version of the VGA2USB drivers and 
application from the Windows section of the Download page. 
Tip: Make sure you note the download destination folder.

3 Unzip the downloaded file. Tip: Right-click on the .zip file and 
choose Extract All.
age 12 Epiphan Frame Grabber
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4 Run the Setup Utility (setup.exe) and follow the prompts.

5 Connect your Frame Grabber, refer to the appropriate section:
• 5. “Connecting a VGA2USB Device” on page 16
• 6. “Connecting a DVI2USB Device” on page 18
• 7. “Connecting a DVI2USB Solo Device” on page 20
• 8. “Connecting a DVI2USB Duo Device” on page 22
• 9. “Connecting a KVM2USB Device” on page 24
Tip: If, after connecting your Frame Grabber, Windows 
displays the Found New Hardware Wizard, respond to the 
prompts before continuing with Step 6.

6 Open the Windows Device Manager and confirm that 
Windows has detected your product. Tip: Refer to 
10. “Troubleshooting” on page 26 if you encounter problems. 
ser Guide Page 13
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4. Installing the Mac OS X 
VGA2USB/DVI2USB drivers and 
application

You must install the VGA2USB/DVI2USB software on your Mac 
OS X video capture workstation before connecting the Frame 
Grabber to the workstation USB port. This single download 
includes the video capture application (v2u), the QuickTime 
digitizer (vdig), and the VGA2USB/DVI2USB USB device driver. 

To install the VGA2USB/DVI2USB drivers and application

1 Download the latest software release to your Mac OS X video 
capture workstation. Browse to 
http://www.epiphan.com/products/ to locate the Download 
page for your Frame Grabber and scroll down to the 
Macintosh section.

2 Download the latest version of the drivers and application that 
will run on your system. Tip: Make sure you note the 
download destination folder.

3 Untar the downloaded file. Tip: Double-click on the .tar file to 
unpack it.

4 Double-click on the .pkg file and follow the prompts.
age 14 Epiphan Frame Grabber
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5 Connect your Frame Grabber, refer to the appropriate section:
• 5. “Connecting a VGA2USB Device” on page 16
• 6. “Connecting a DVI2USB Device” on page 18
• 7. “Connecting a DVI2USB Solo Device” on page 20
• 8. “Connecting a DVI2USB Duo Device” on page 22
• 9. “Connecting a KVM2USB Device” on page 24

6 Open System Profiler and expand the USB Device Tree to 
confirm that the device is recognized. Tip: Refer to 
10. “Troubleshooting” on page 26 if you have problems.
ser Guide Page 15
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5. Connecting a VGA2USB Device
VGA2USB Frame Grabbers (including LR, HR, and Pro) capture 
images from most VESA-compatible VGA sources. Using the 
Epiphan video capture application installed on a video capture 
workstation you can view and record the captured images. This 
section shows VGA2USB (including LR, HR, and Pro) package 
contents and describes and how to connect a VGA2USB Frame 
Grabber to your VGA source and to a video capture workstation.

VGA2USB (including LR, HR, and Pro) package contents

VGA2USB

VGA2USB LR

VGA2USB HR

VGA2USB Pro

Power
Adapter

(LR/HR/Pro)

VGA Adapter

VGA SplitterVGA Cable

USB
Cable
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To connect a VGA2USB (including LR, HR, and Pro)

Make sure that the video capture application is installed on the 
video capture workstation before connecting the Frame Grabber.

1 If you are connecting a VGA2USB LR, HR, or Pro Frame 
Grabber, connect the power adapter to the Frame Grabber. 

2 Use the VGA cable to connect the VGA signal output source to 
the Frame Grabber VGA port.

You can use a VGA splitter to split the VGA signal between an 
external monitor and the Frame Grabber, (not recommended). 
You can also use the VGA adaptor if your VGA signal output 
source has a male connector.

3 Use the USB cable to connect the Frame Grabber to a USB 2.0 
port on the video capture workstation.

Video Capture
Workstation

Equipment with
VGA Signal Output

VGA

Cable

USB

Cable

VGA Signal
Output

VGA Input

Power/Status/
Capture LEDs

USB Output

Power Input
(LR/HR/Pro)

USB Input
ser Guide Page 17
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6. Connecting a DVI2USB Device
The DVI2USB Frame Grabber captures images from most 
VESA-compatible DVI sources. You can also use the DVI2USB 
Frame Grabber to capture VGA images from most 
VESA-compatible VGA sources using a VGA to DVI cable.

Using the Epiphan video capture application installed on a video 
capture workstation, you can view and record the captured 
images.

This section shows DVI2USB package contents and describes how 
to connect a DVI2USB Frame Grabber to a DVI or VGA source 
and to a video capture workstation. 

DVI2USB package contents

USB
Cable DVI Cable

DVI2USB

VGA Adapter

VGA Splitter
DVI to

VGA Cable

Power
Adapter
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To connect a DVI2USB

Make sure that the video capture application is installed on the 
video capture workstation before connecting the DVI2USB Frame 
Grabber. 

1 Connect the power adapter to the DVI2USB Frame Grabber. 

2 Use the DVI cable to connect the DVI signal output source to 
the DVI2USB DVI port. 

If you are connecting the VGA2USB Frame Grabber to a VGA 
source, use the DVI to VGA cable to connect the VGA signal 
output source to the DVI2USB DVI port.

3 Use the USB cable to connect the DVI2USB to a USB 2.0 port on 
the video capture workstation.

Video Capture
Workstation

Equipment with
DVI Signal Output

DVI

Cable

USB

Cable

DVI Input
DVI Signal

Output

USB Input

Power/Status/
Capture LEDsUSB Output

Power Input
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7. Connecting a DVI2USB Solo 
Device

THe DVI2USB Solo Frame Grabber captures images from most 
VESA-compatible DVI sources. Using the Epiphan video capture 
application installed on a video capture workstation, you can 
view and record the captured images. 

This section shows DVI2USB Solo package contents and describes 
how to connect a DVI2USB Solo to a DVI source and to a video 
capture workstation.

DVI2USB Solo package contents

Power
Adapter

USB
Cable

DVI2USB Solo

DVI Cable
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To connect a DVI2USB Solo

Make sure that the video capture application is installed on the 
video capture workstation before connecting the DVI2USB Solo 
Frame Grabber. 

1 Connect the power adapter to the DVI2USB Solo Frame 
Grabber. 

2 Use the DVI cable to connect the DVI signal output source to 
the DVI2USB Solo DVI port.

3 Use the USB cable to connect the DVI2USB Solo to a USB 2.0 
port on the video capture workstation.

Video Capture
Workstation

Equipment with
DVI Signal Output

DVI Cable USB

Cable

DVI
InputDVI Signal

Output

USB Input

Power/Status/
Capture LED

USB Output

Power Input
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8. Connecting a DVI2USB Duo 
Device

The DVI2USB Duo Frame Grabber captures images from most 
VESA-compatible dual-link DVI sources. Using the Epiphan 
video capture application installed on a video capture 
workstation you can view and record the captured images. 

This section shows DVI2USB Duo package contents and describes 
how to connect a DVI2USB Duo to a dual-link DVI source and to 
a video capture workstation.

DVI2USB Duo package contents

Power
Adapter

Dual-Link
DVI Cable

USB
Cable

DVI2USB Duo
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To connect a DVI2USB Duo

Make sure that the video capture application is installed on the 
video capture workstation before connecting the DVI2USB Duo 
Frame Grabber. 

1 Connect the power adapter to the DVI2USB Duo Frame 
Grabber. 

2 Use the dual-link DVI cable to connect the dual-link DVI signal 
output source to the DVI2USB Duo dual-link DVI port.

3 Use the USB cable to connect the DVI2USB Duo to a USB 2.0 
port on the video capture workstation.

Video Capture
Workstation

Equipment with Dual-link
DVI Signal Output

Dual-link 

DVI Cable

USB

Cable

Dual-link
DVI InputDual-link

DVI Signal
Output

USB Input
Power/Status/
Capture LEDs

USB Output

Power Input
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9. Connecting a KVM2USB Device
The KVM2USB Frame Grabber provides full Keyboard-Video-
Mouse (KVM) capabilities so that you can use the KVM2USB to 
manage a headless server from an administrator’s PC. The 
headless server can be a PC running Windows, Linux, or 
Mac OS X. The administrator’s PC can be running Windows or 
Mac OS X.

• If the headless server has a VGA port and PS2 mouse and 
keyboard ports you can connect the KVM2USB directly. 

• The KVM2USB also comes with PS/2 to USB adapters that 
you can use if the headless server only has USB ports for 
mouse and keyboard connections.

• The KVM2USB video connector is a VGA connector. 
However, the KVM2USB is compatible with most DVI to VGA 
adapters if the headless server has a DVI port. 

This section shows KVM2USB package contents and describes 
how to connect a KVM2USB to a headless server and to the 
administrator’s PC.

KVM2USB package contents

USB
Cable KVM Cable

KVM2USB
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To connect a KVM2USB

Make sure that the video capture application is installed on the 
video capture workstation before connecting the KVM2USB 
Frame Grabber. 

1 Connect the multi-connector end of the KVM cable to the 
Headless server keyboard, video, and mouse ports. Use PS/2 
to USB and DVI to VGA adapters if required.

2 Connect the single-connector end of the KVM cable to the 
KVM2USB KVM input port.

3 Use the USB cable to connect the KVM2USB to a USB 2.0 port 
on the administrator’s PC.

4 Start the video capture application and use the options on the 
KVM menu to start and stop KVM operation.

Administrator’s
PC or laptop

Keyboard
Video

Mouse (KVM)

Headless
Server

USB Cable

KVM InputKeyboard
and Mouse
Connections

VGA Signal
Output

Status/
Capture LED

Power Input

USB Output

USB Input
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10.Troubleshooting
If you experience any difficulty installing your Frame Grabber, 
review the following items prior to contacting technical support:

• Confirm that the Frame Grabber is connected to a USB 2.0 
port. As shown below, Windows Device Manager reports a 
USB 2.0 port as an Enhanced Host Controller and Macintosh 
System Profiler reports a USB 2.0 port as a High-Speed Bus.

USB 2.0 ports on Windows and Mac OS X

For additional assistance with USB driver troubleshooting, 
browse to http://www.epiphan.com/products/ and locate 
the Download page for your Frame Grabber.

• If included in the Frame Grabber package, always use the 
power adapter to ensure your Frame Grabber is receiving 
sufficient power. Also, plug in the power before connecting 
the Frame Grabber to your equipment.

• Observe the behavior of your Frame Grabber LED indicators 
before requesting support. See “VGA2USB, DVI2USB, and 
KVM2USB LEDs” on page 27 for LED information.

• Whenever possible, when splitting VGA connections, use an 
active VGA splitter rather than a VGA Y-adapter to help 
maintain a cleaner video signal.

Windows Device Manager

Mac OS X System Profiler
age 26 Epiphan Frame Grabber
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• If, after following the installation steps, you are still having 
problems, close all applications and restart the video capture 
workstation. When the workstation comes back online, open 
the Windows Device Manager or Mac OS X System Profiler to 
confirm that the Frame Grabber is detected.

VGA2USB, DVI2USB, and KVM2USB LEDs

LED Activity Description

Power 
(PWR)

Red Normal operation, the Frame Grabber is 
receiving power.

Off Power is disconnected from the Frame 
Grabber.

Capture 
(CAP)

Flashing 
Amber

The video capture application is running 
and has found the Frame Grabber. The 
Frame Grabber is capturing images.

On The Frame Grabber is not receiving a 
VGA/DVI signal, or cannot adjust video 
capture parameters.

Status 
(STAT)

Off The Frame Grabber is not recognized by 
the operating system.

Flashing 
Green

Normal operation, the Frame Grabber is 
initialized and ready to capture.
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11.About Epiphan frame grabbing 
technology

This chapter describes how the components required for 
capturing, displaying, recording, and broadcasting images from a 
VGA or DVI source with an Epiphan Frame Grabber work 
together. This chapter also contains a glossary of the terms used 
in this document.

This chapter contains the following sections: 

• The VGA or DVI video source
• The Frame Grabber
• The video capture workstation
• Glossary of Terms

Capturing, displaying, recording, and broadcasting VGA or DVI 
images requires the following components:

• A VGA or DVI video source to capture images from.
• An Epiphan Frame Grabber that captures images from the 

video source.
• A video capture workstation that displays, records, and 

broadcasts the images captured by the Frame Grabber.

Figure 3: Capturing, displaying, and recording images

Video Capture
Workstation

(Display, Record, and Broadcast
Captured images)

Video Source
(Equipment with VGA, DVI, or

Dual-DVI Output)

Epiphan
Frame Grabber

USB Cable

VGA, DVI or
Dual-DVI

Cable
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The VGA or DVI video source
Image capture begins with a VESA-compatible VGA, DVI, or 
dual-DVI video source. Virtually all personal computers as well 
as almost any device that displays images includes a VESA-
compatible VGA or DVI video connection that you can connect an 
Epiphan Frame Grabber to. To capture the video images from a 
VGA or DVI source you connect the video source directly to a 
suitable Epiphan Frame Grabber using a suitable cable.

Figure 4: Video source (VGA, DVI, or dual-DVI output)

Epiphan Frame Grabbers can capture video in a wide range of 
video formats including analog and digital video formats, 
resolutions from 640 x 480 to 2048 x 2048, frame rates up to 12 fps 
at 2048 x 2048 resolution and up to 60 fps at 1024 x 768. For 
information about all of the video source features that Epiphan 
Frame Grabbers support, see the Frame Grabbers Comparison 
Table on the Epiphan Web Site.

The Frame Grabber
The Frame Grabber that you select depends on the video format 
produced by the video source. You can connect the basic 
VGA2USB Frame Grabber to most VGA video sources and 
successfully capture images. 

For high resolution images or high frame rates, you should 
upgrade to the VGA2USB LR, HR, or Pro, depending on your 
detailed video format, frame rate, and resolution requirements 
and budget. See the Frame Grabbers Comparison Table on the 

Video Source
(Equipment with VGA, DVI, or

Dual-DVI output)
age 30 Epiphan Frame Grabber
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Epiphan Web Site for specifications of the all of the VGA2USB 
Frame Grabbers. You should select the Frame Grabber that 
matches or exceeds the output of your video source.

For most DVI video sources, you can connect the DVI2USB Frame 
Grabber. You can also use the DVI2USB Frame Grabber to 
capture VGA images. For higher resolution DVI sources you can 
upgrade to the DVI2USB Solo Frame Grabber. For dual-DVI 
sources you can use the DVI2USB Duo Frame Grabber. See the 
DVI2USB Frame Grabbers Comparison Table on the Epiphan 
Web Site for specifications of the different DVI2USB Frame 
Grabbers. You should select the DIV2USB Frame Grabber that 
matches or exceeds the output of your video source.

Figure 5: Video source and Frame Grabber

To get the signal from the video source to the Frame Grabber you 
connect the two devices with the appropriate cable. In most cases 
the cable you need comes in the package with your Frame 
Grabber.

For example, if your video source is VESA-compatible VGA 
source and if you want to capture images with a resolution of up 
to 1600 x 1200 at a frame rate of 30 frames a second then you 
could choose a VGA2USB HR or VGA2USB Pro. Both of these 
Frame Grabbers ship with the VGA video cable and adapters that 
you need to connect the video source directly to your Frame 
Grabber.
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How Epiphan Frame Grabbers operate
The Frame Grabber is a hardware device that captures images 
(also called frames) from analog VGA signals or digital DVI 
streams. Capturing images means reading data from the VGA or 
DVI signal and converting this data into a digital image. 

The Frame Grabber synchronizes itself with the video source to 
capture images at the resolution and color depth output by the 
video source or at the maximum color depth and resolution 
supported by the Frame Grabber. The Frame Grabber captures 
images at its own frame rate up to the maximum frame rate 
capacity of the Frame Grabber.

Epiphan Frame Grabbers perform the following functions to 
optimize and compress captured image data. The aim is to reduce 
the amount of data required for each captured image and 
optimize data transmission to the video capture workstation. 
These functions include:

• Pre-compression using technology developed by Epiphan to 
clean up and optimize the image. Pre-compression reduces the 
amount of data required for each image and improves the 
performance of the standard compression algorithms also 
built into most Epiphan Frame Grabbers. See Pre-compression 
of computer-generated images on the Epiphan Web Site for a 
description of pre-compression.

• Lossless image compression using industry standard image 
compression algorithms.

• Optional on-board cropping of the image. 
• Color space conversion. 
• USB transfer acceleration. 

The result is the Frame Grabber captures a large amount of image 
data, converts the image data to RGB format at the maximum 
color depth that the Frame Grabber supports at the operating 
resolution, compresses and optimizes the data and then transmits 
the data to the video capture workstation.

All Epiphan Frame Grabbers use USB 1.1 and USB 2.0 to transfer 
captured images to the video capture workstation. USB 2.0 is 
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recommended especially for high resolution and high frame rate 
applications because USB 2.0 supports much higher data transfer 
rates than USB 1.1. The USB version used depends on the video 
capture workstation.

The video capture workstation
The video capture workstation is a personal computer running a 
supported operating system such as Windows (2000, XP or Vista), 
Mac OS X Panther, or supported versions of Linux. For video 
capture workstation system requirements see Chapter 2. “System 
Requirements” on page 11.

Figure 6: Video source, Frame Grabber and video capture 
workstation

To be a video capture workstation the PC must include a USB 
device driver that can receive images from Epiphan Frame 
Grabbers. The video capture workstation must also include video 
capture application software for processing captured images 
according to your requirements. For example, you may want the 
video capture application software to display captured images or 
you may also want to record and print captured images, or you 
may want to share captured images by broadcasting them across 
the Internet to a remote location.

An Epiphan Frame Grabber is compatible with Windows, Mac 
OS X Panther or Linux PC platforms. The video capture 
workstation components are similar on each of these platforms. A 
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notable difference is that each platform includes different image 
processing application programming interfaces (APIs):

• On Windows 2000, XP, and Vista the Epiphan USB device 
driver and video capture application is compatible with the 
Microsoft DirectShow API.

• On Mac OS X the Epiphan USB device driver and video 
capture application is compatible with the Apple QuickTime 
API.

• On Linux the Epiphan USB device driver and video capture 
application is compatible with the Video4Linux V4L API.

The following sections describe the video capture workstation 
software components and APIs on each supported video capture 
application platform.

• “Windows video capture application software” on page 35
• “Mac OS X video capture workstation software” on page 40
• “Linux video capture workstation software” on page 42

About kernel mode and user mode
Some video capture workstation software components operate in 
kernel mode and some in user mode. Kernel mode programs are 
usually always running in the background and are usually not 
started and stopped by users. Kernel mode programs are usually 
configured from a central location such as the Windows control 
panel. Most software that communicates directly with hardware 
components operate in kernel mode. On all operating systems the 
Epiphan USB device driver is a kernel mode application.

User mode programs are programs that users run to perform a 
task such as word processing, drawing graphics, or recording 
captured images. Users start, stop, use and configure user mode 
programs. User mode programs do not usually communicate 
directly with hardware components. They communicate with 
kernel mode programs and it is the kernel mode programs that 
communicate with the hardware components. The Epiphan video 
capture application is a user mode program.
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Windows video capture application software
The following software components operate on a video capture 
workstation running Windows 2000, XP, or Vista:

• The Epiphan USB device driver
• DirectShow
• The Epiphan capture API
• The Epiphan video capture application
• Video codecs

The Epiphan USB device driver

The Windows 2000, XP and Vista Epiphan USB device driver 
receives images from an Epiphan Frame Grabber and delivers the 
images to the Epiphan capture API and to DirectShow. Before 
delivering the images the Epiphan USB device driver also 
performs image adjustment to improve the quality of the image. 
Image adjustments include setting the sampling phase, PLL 
adjustments, and Horizontal shift. See “Configuring image 
adjustments” on page 136 for more information about image 
adjustments.

The USB device driver can also change the color depth of the 
captured image before sending the image to the video API. For 
example, if the Frame Grabber is capturing the frames at a color 
depth that is different than that required by the video capture 
application, the USB device driver converts the images to the 
required color depth.
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Figure 7: Windows video capture workstation software

Using the Epiphan software development kit (SDK) you can also 
create custom USB device drivers that incorporate the functions 
that you need.

On Windows video capture workstations the Epiphan USB device 
driver installs a control panel application (Figure 8).

From this control panel application you can view the status of the 
Frame Grabbers connected to the video capture workstation. You 
can also configure image adjustments for each Frame Grabber 
and configure how the Epiphan USB device driver communicates 
with DirectShow. See “Configuring DirectShow options” on 
page 143.

If you have successfully installed the Epiphan USB device driver, 
when you connect a Frame Grabber, the name of the Frame 
Grabber appears in the Windows Device Driver under Imaging 
Devices. For example, if you installed a DVI2USB Solo Frame 
Grabber the name of the imaging device would be “DVI2USB 
Solo by Epiphan Systems Inc”.
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Figure 8: Epiphan USB device driver

You can also find the Frame Grabber from the Windows Control 
Panel by opening the Scanners and Cameras control panel 
application.

DirectShow

DirectShow is the standard Microsoft DirectShow multimedia 
API. The Epiphan USB device driver can send captured images 
directly to DirectShow. This means that any DirectShow-
compatible application can receive captured images. For example, 
you can use applications such as VirtualDUB to record avi files, 
Microsoft Media Encoder to record wmv files, and RealProducer 
to record rm files all consisting of a series of captured images sent 
to DirectShow by the Epiphan USB device driver. See “Using a 
DirectShow application to record video files” on page 107.
You can also create your own custom DirectShow-compatible 
video capture application to record captured images from 
DirectShow.

The Epiphan capture API

The Epiphan capture API also receives captured images from the 
Epiphan USB device driver. The Epiphan capture API is 
optimized for processing Epiphan Frame Grabber captured 
images. The Epiphan capture API analyzes individual images, 
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performs on-device cropping, handles video mode changes and 
also supports KVM functions if you are using a KVM2USB frame 
grabber.

The Epiphan capture API is an alternative to using DirectShow to 
capture images. The Epiphan capture API delivers captured 
images to the Epiphan video capture application. You can use the 
Epiphan software development kit (SDK) to create your own 
custom video capture application to record captured images from 
the Epiphan capture API.

The Epiphan video capture application

The Epiphan video capture application receives and processes 
captured images from the Epiphan capture API. Using the 
Epiphan video capture application you can:

• Display, print, and copy captured images to the Windows 
clipboard to be pasted into another application. 

• Record captured images as bmp, jpeg, or png image files.
• Record captured images by sending them to a video codec so 

that they can be saved as Windows AVI video files. 
• Share captured images by broadcasting them over the Internet 

in real time.
Using the Epiphan SDK you can create your own custom video 
capture application for processing and recording captured 
images received from DirectShow or from the Epiphan capture 
API. By developing your own custom software application you 
can include the features that you need according to your 
requirements.

Video codecs

Many different video codecs are available for recording captured 
images as video files. The Epiphan video capture application is 
compatible with most Windows AVI video codecs. To use a video 
codec you must obtain and install the video codec software. 
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Figure 9: Selecting a video codec using the Epiphan video 
capture application

After you install the video codec on the video capture 
workstation you configure the Epiphan video capture application 
or your custom video capture application to send captured 
images to the video codec. From the Epiphan video capture 
application you can also configure settings for the video codec 
that you select. See Chapter 15. “Recording videos” on page 97.
The video codec and codec settings to choose depend on your 
requirements. You may need to try several different codecs and 
change configuration settings to see which codec best fits your 
requirements. Epiphan recommends the ffvfw video codec for 
most Windows video capture applications. See “Installing the 
ffvfw video codec pack” on page 100.
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Mac OS X video capture workstation software
The following software components operate on a video capture 
workstation running Mac OS X Panther:

• The Epiphan USB device driver
• The Epiphan capture API
• Apple QuickTime and the Epiphan QuickTime component
• The Epiphan video capture application

Figure 10:Mac OS X video capture workstation software

The Epiphan USB device driver

The Mac OS X Epiphan USB device driver receives images from 
an Epiphan Frame Grabber and delivers the images to the 
Epiphan capture API. Before delivering the images, the Epiphan 
USB device driver also performs image adjustment to improve 
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the quality of the image. Image adjustments include setting the 
sampling phase, PLL adjustments, and Horizontal shift. See 
“Configuring image adjustments” on page 136 for more 
information about image adjustments.

The USB device driver can also change the color depth of the 
captured image before sending the image to the video capture 
API. For example, if the Frame Grabber is capturing the frames at 
a color depth that is different than that required by the video 
capture application, the USB device driver converts the images to 
the required color depth.

Using the Epiphan software development kit (SDK) you can also 
create custom USB device drivers that incorporate the functions 
that you need.

The Epiphan capture API

The Epiphan capture API receives captured images from the 
Epiphan USB device driver. The Epiphan capture API is 
optimized for processing Epiphan Frame Grabber captured 
images. The Epiphan capture API analyzes individual images, 
performs on-device cropping, handles video mode changes and 
also supports KVM functions if you are using a KVM2USB frame 
grabber.

The Epiphan capture API sends captured images to the Epiphan 
QuickTime component and to the Epiphan video capture 
application. You can use the Epiphan software development kit 
(SDK) to create your own custom video capture application to 
record captured images from the Epiphan capture API.

Apple QuickTime and the Epiphan QuickTime component

Apple QuickTime is the standard Mac OS X QuickTime 
multimedia API. The Epiphan capture API sends captured 
images to the Epiphan QuickTime component. The Epiphan 
QuickTime component sends the captured images to QuickTime 
where they can be recorded or otherwise processed by any 
QuickTime-compatible video recording application. For example, 
you can use applications such as QuickTime Pro or HackTV 
Carbon to record QuickTime video files consisting of a series of 
ser Guide Page 41



11. About Epiphan frame grabbing technology The video capture workstation

P

captured images sent to the QuickTime API by the Epiphan USB 
device driver.You can also create your own custom QuickTime-
compatible video capture application to record captured images 
from QuickTime. See “Recording videos for Mac OS X” on 
page 110.

The Epiphan video capture application

The Epiphan video capture application receives and processes 
captured images from the Epiphan capture API. Using the 
Epiphan video capture application you can:

• Display, print, and copy captured images to the MAc OS X 
clipboard to be pasted into another application. 

• Save captured images as bmp, jpeg, png, or tiff image files.

For more information about the Mac OS X Epiphan video capture 
application, see Chapter 13. “Mac OS X video capture 
application” on page 79.

Using the Epiphan SDK you can create your own custom video 
capture application for processing and recording captured 
images received from QuickTime or from the Epiphan capture 
API. By developing your own custom software application you 
can include the features that you need according to your 
requirements.

Linux video capture workstation software
Epiphan provides the Epiphan USB device driver and the 
Epiphan capture API for Linux. Epiphan does not provide a video 
capture application for Linux. However, the USB device driver is 
compatible with Video4Linux so you can use Video4Linux-
compatible applications to receive and process captured images.

You can also use the Epiphan Linux SDK to write your own 
custom video capture application that receives captured images 
from the Epiphan capture API. The following software 
components operate on a video capture workstation running 
Linux:

• The Epiphan USB device driver
• Video4Linux
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• The Epiphan capture API
• V4L custom video capture applications

Figure 11:Linux video capture workstation software

The Epiphan USB device driver

The Linux Epiphan USB device driver receives images from an 
Epiphan Frame Grabber and delivers the images to the Epiphan 
capture API and to Video4Linux. Before delivering the images the 
Epiphan USB device driver also performs image adjustment to 
improve the quality of the image. Image adjustments include 
setting the sampling phase, PLL adjustments, and Horizontal 
shift. See “Configuring image adjustments” on page 136 for more 
information about image adjustments.

The USB device driver can also change the color depth of the 
captured image before sending the image to the video API. For 
example, if the Frame Grabber is capturing the frames at a color 
depth that is different than that required by the video capture 
application, the USB device driver converts the images to the 
required color depth.
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The Epiphan USB device driver may not be available for your 
version of Linux. Epiphan does not provide source code for the 
Epiphan USB device driver. But you can contact Epiphan if you 
need an Epiphan USB device driver compiled for a specific Linux 
kernel version or kernel setting.

Using the Epiphan software development kit (SDK) you can also 
create custom USB device drivers that incorporate the functions 
that you need.

Video4Linux

Video4Linux (V4L) is a Linux video capture API. The Epiphan 
USB device driver can send captured images directly to 
Video4Linux. This means that any Video4Linux-compatible 
application can receive captured images. You can use a 
Video4Linux-compatible application to record a series of 
captured images as a video in the video format supported by the 
Video4Linux application. You can also create your own custom 
Video4Linux-compatible video capture application to record 
captured images from Video4Linux.

The Epiphan capture API

The Epiphan capture API also receives captured images from the 
Epiphan USB device driver. The Epiphan capture API is 
optimized for processing Epiphan Frame Grabber captured 
images. The Epiphan capture API analyzes individual images, 
performs on-device cropping, handles video mode changes and 
also supports KVM functions if you are using a KVM2USB Frame 
Grabber.

The Epiphan capture API is an alternative to using Video4Linux 
to capture images on Linux video capture workstations. You can 
use the Epiphan software development kit (SDK) to create your 
own custom video capture application to record captured images 
from the Epiphan capture API.
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V4L custom video capture applications

Epiphan does not provide a video capture application for Linux. 
However, you can use Video4Linux-compatible applications to 
perform many video capture operations such as recording images 
or video, copying, printing and saving images, or broadcasting 
images across the Internet. You can also use the Epiphan Linux 
SDK to create your own custom video capture application. The 
SDK along with some example applications is available from the 
downloads page of the Epiphan Web Site. To download the latest 
version, browse to http://www.epiphan.com/products/ and 
locate the downloads page for your product.

Glossary of Terms
This glossary describes many of the terms used in this Epiphan 
Frame Grabber User Guide.

Color depth, bits per pixel (bpp)

Color depth or bits per pixel (bpp) (also known as color 
resolution) is a computer graphics term describing the number of 
bits used to represent the color of a pixel in a bitmapped image or 
video frame. Epiphan Frame Grabbers support a number of color 
depths:

• RGB 24 bits per pixel, RGB 8:8:8 format: also known as true 
color and millions of colors, 24-bit color is the highest color 
depth normally used. 24bpp can display over 16.7 million 
colors. Most video codecs require a color depth of 24 bpp. 

• RGB 16 bits per pixel, RGB 5:6:5 format: also known as high 
color and thousands of colors. 16 bpp may look as good as 24 
bpp in many applications while using less data. However 
more complex images may not look as good with a 16 bpp 
color depth. 16 bpp can display over 65,536 colors.

• RGB 8 bits per pixel, RGB 3:3:2, 3:2:3, 2:3:3: uses much less data 
than 16 bpp but can only display 256 colors. 8 bpp is usually 
only useful for video streams with very low color depth.
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• 8 bits per pixel, grayscale 256 levels: uses a similar amount of 
data as RGB 8 bpp but images are black, white, and shades of 
gray. Usually you would only use 8 bpp grayscale if your 
video source or codec used this color depth or to reduce file 
size.

• 5 bits per pixel, grayscale 32 levels: a grayscale format that has 
fewer levels of gray and uses less data than grayscale 256 
levels. Usually you would only use 5 bpp grayscale if your 
video source or codec used this color depth or to reduce file 
size.

• Black and white: a very low quality and low data format that 
uses only black and white. Usually you would only use black 
and white if your video source is producing a black and white 
video signal.

• 16 bits per pixel, YUY2(422), UYVY: a color format used by 
many video sources. Similar to RGB 16 bpp but uses 
compression and other techniques to improve the video 
signal. Epiphan Frame Grabbers and the video capture 
application convert YUY2(422), UYVY video images to RGB, 
grayscale or black and white images.

All color depths are not supported by all video codecs or image 
file formats. Most video codecs and image file formats support 
RGB 24 bpp. It may be difficult to find a video codec that supports 
other color depths. Some image file formats do not support all 
color depths. Epiphan Frame Grabber web broadcasting operates 
at RGB 24 bpp.

Epiphan Frame Grabbers capture images at the color resolution of 
the video source up to the maximum resolution supported by the 
Frame Grabber. The maximum resolution supported by the 
VGA2USB Frame Grabber is 16 bits per pixel (bpp). The 
maximum supported by all other Epiphan Frame Grabbers is 24 
bpp.

Capture, image capture, frame grabbing

Epiphan products can capture VGA, DVI, or dual DVI images. 
Capturing VGA data involves using a Frame Grabber to digitize 
analog VGA signals and transmit the digitized images as frames 
over a USB connection to the Epiphan video capture application.
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Capturing DVI or dual DVI data involves using a Frame Grabber 
to convert DVI or dual DVI data into frames that can be 
transmitted over a USB connection to the Epiphan video capture 
application.

Capturing can also compress images before they are transmitted. 
Frames must be captured before they are displayed, printed, or 
recorded by the Epiphan video capture application.

Color resolution

See “Color depth, bits per pixel (bpp)” on page 45.

DVI

Digital Visual Interface (DVI) is a digital standard for 
transmitting visual data from a graphics source (such as a PC 
video card) to a display device (such as a computer monitor). 
Many devices that output digital visual images use the DVI 
standard for transmitting visual data. All Epiphan DVI2USB 
Frame Grabbers capture digital DVI frames and convert them to 
digital signals that are transmitted to the Epiphan video capture 
application using a USB connection. This USB data is then 
interpreted and displayed using the Epiphan video capture 
application.

Frame Grabber

A hardware device that captures frames from analog VGA signals 
or digital DVI streams. Epiphan Frame Grabbers may modify 
captured frames and compress them before sending them to a 
video capture workstation over a USB connection.

Frame

A frame is one of the many still images which can be combined to 
create a moving picture such as a video image. The term frame 
comes from the film industry. Film images are recorded on a strip 
of photographic film and each image looks like a framed picture.
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Record

The process of saving (or recording) captured frames as video 
files or as sets of image files. Recording requires that frames are 
first captured before being recorded.

VGA

Video Graphics Array (VGA) is an analog standard for 
transmitting visual data from a graphics source (such as a PC 
video card) to a display device (such as a computer monitor). 
VGA originated in 1988. Most PCs and many other devices that 
output analog visual images use the VGA standard or extensions 
to the VGA standard for transmitting visual data. All Epiphan 
VGA2USB Frame Grabbers capture analog VGA frames and 
convert them to digital signals that are transmitted to the Epiphan 
video capture application using a USB connection. This USB data 
is then interpreted and displayed using the Epiphan video 
capture application.

VGA modes

A VGA mode describes the timing of the VGA signals sent by a 
VGA source to a VGA display device (or Frame Grabber). The 
VGA source and receiver (for example a monitor) must agree on 
the VGA mode so that the VGA display device can decode the 
timing of the VGA signal and display images.

A VGA signal consists of a series of frames. Each frame is a single 
image displayed by a VGA display device or captured by a Frame 
Grabber. A VGA frame is made up of horizontal lines. Each line is 
made up of pixels. The pixels in each line are transmitted from 
left to right. The lines in each frame are transmitted from top to 
bottom. If the VGA signal is interlaced each frame consists of 
every other line of the frame. An interlaced signal contains less 
data and so displays faster but also results in a lower quality 
image.

The timings in a VGA mode start with the refresh rate; which 
defines how often a new frame is sent. A VGA mode also 
indicates if the signal is interlaced.
age 48 Epiphan Frame Grabber



11. About Epiphan frame grabbing technology Glossary of Terms

U

Next a VGA mode describes the timing of the horizontal signals. 
These horizontal timings define how the data that makes up each 
line is transmitted. The line begins with the active area, which 
contains the RGB values for each pixel in the line. The active area 
is followed by a blanking region that contains black pixels. Inside 
the blanking interval, a horizontal sync pulse is transmitted to 
keep the signals synchronized. The blanking interval before the 
sync pulse is called the front porch, and the blanking interval after 
the sync pulse is called the back porch. The time between 
horizontal sync pulses is called the sync time. The sync polarity 
designates whether the sync pulse is positive or negative.

The vertical timings work the same way to define how the data 
that makes up each frame is transmitted. A frame begins with the 
active video area that contains all of the lines in the frame. The 
vertical signal also includes a vertical synch pulse that is timed 
according to the vertical sync time. The vertical blanking intervals 
are also called the front porch and back porch. Finally the vertical 
synch polarity designates whether the vertical sync pulse is 
positive or negative.

Video capture application

The Epiphan software that intercepts the frames (images) sent by 
the Frame Grabber over the USB connection. Using the video 
capture application you can display, print and record captured 
frames. You can also use the video capture application to transmit 
captured frames over the Internet.

Video capture workstation

A computer running Windows, Mac OS X or Linux that you can 
use to record captured frames. You connect your Frame Grabber 
to the video capture workstation with a USB connection. You 
must also install the Epiphan video capture application on the 
video capture workstation. If the video capture workstation can 
connect to the Internet you can use the video capture application 
to broadcast captured images over the Internet.
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12.Windows video capture 
application

This chapter describes common functions and features of the 
Epiphan video capture application. Most of the information in 
this chapter describes the Windows 2000, XP, and Vista version of 
the Epiphan video capture application. However the information 
in this chapter also applies to the Linux version of the Epiphan 
video capture application software. 

Note: For information about the Mac OS X version of the Epiphan 
video capture application, see Chapter 13. “Mac OS X video 
capture application” on page 79.

• For details about how to record images or video, see 
Chapter 14. “Recording image files” on page 91 and 
Chapter 15. “Recording videos” on page 97. 

• For details about how to broadcast captured images over the 
Internet, see Chapter 16. “Web Broadcasting” on page 121. 

• For details about how to set up KVM, see Chapter 17. “Using 
the KVM2USB Frame Grabber” on page 129.

• For special advanced topics, see Chapter 18. “Advanced 
topics” on page 133.

• For many useful How To procedures see the How To page of 
the Epiphan Web Site.

This chapter assumes that you have followed the instructions in 
the Frame Grabber Installation Guide shipped with your Frame 
Grabber and also available as chapters 2 to 10 of this User Guide. 
To start using this chapter you should have:

• Selected a video capture workstation that meets the system 
requirements described in your install guide and in 
Chapter 2. “System Requirements” on page 11. 

• Successfully installed the Epiphan USB device drivers, and 
video capture application on the video capture workstation as 
described in Chapter 3. “Installing the Windows 
VGA2USB/DVI2USB drivers and application” on page 12.
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• Connected your Frame Grabber to a VGA, DVI or dual-DVI 
source.

• Connected your Frame Grabber to a USB port on your video 
capture workstation.

• If required you should have also connected power to the 
Frame Grabber.

Figure 12:Connecting Epiphan Frame Grabbers

This chapter describes:

• Upgrading to the latest software version
• Starting the video capture application
• Common procedures
• Menus
• Toolbar
• Status bar
• Shortcut keys
• Recording, display, KVM and sharing options
• Windows Epiphan USB device driver

Video Capture
Workstation

(Display, Record, and Broadcast
Captured images)

Video Source
(Equipment with VGA, DVI, or

Dual-DVI Output)

Epiphan
Frame Grabber

USB Cable

VGA, DVI or
Dual-DVI

Cable
age 52 Epiphan Frame Grabber



12. Windows video capture application Upgrading to the latest software version

U

Upgrading to the latest software 
version

From time to time Epiphan makes new versions of all Epiphan 
Frame Grabber software available from the Epiphan web site. To 
confirm that you have the latest video capture application version 
select Check for Updates from the Help menu.

Note: Check for Updates will only recommend an update if 
Epiphan recommends that you install a new version. This will 
happen if the latest version contains significant bug fixes or 
enhancements. If a new video capture application version only 
contains minor changes, Check for Updates may not recommend 
that you install a new version.

In most cases you can upgrade the Epiphan software on your 
Windows or Linux video capture workstation by using normal 
procedures for your operating system to download the latest 
version and install it without uninstalling the previous version.

If you have problems upgrading Windows software, see the 
detailed driver update instructions and install/uninstall 
instructions available from the Windows section of 
http://www.epiphan.com/downloads.

Finding software updates
To find the latest versions of all Epiphan software for Windows 
and Linux go to http://www.epiphan.com/downloads. You can 
also browse to the download page for your Frame Grabber 
product. For example, if you own an Epiphan VGA2USB Frame 
Grabber, you can browse to http://www.epiphan.com and select 
Products > VGA Frame Grabbers > VGA2USB > Download. 

On these download pages you will find the most recent versions 
of:

• This Epiphan Frame Grabber User Guide.
• For Windows: the Epiphan USB device driver and video 

capture application for Windows 2000, Windows XP, and 
Windows Vista.
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• For Linux (i386 and x86_64): pre-compiled drivers for many 
Linux distributions.

• For Macintosh: the latest release of the Epiphan device driver, 
QuickTime component and VGA2USB application compatible 
with MacOS X 10.4 and 10.5 (Intel and PowerPC) and 10.3.

Starting the video capture application
Before starting the video capture application the Frame Grabber 
must be connected to the video capture workstation USB port. If 
required the Frame Grabber should also be connected to power.

Start the video capture application as you would any other 
application installed on the video capture workstation. 

Figure 13:Epiphan video capture application window (Windows 
XP, VGA2USB Frame Grabber)

Title Bar

Toolbar

Captured
Image

Status Bar

Menu
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As the application starts the following messages may appear on 
the video capture application window:

• Detecting Video Mode as the video capture application starts 
up and attempts to connect with the Frame Grabber.

• Tuning Capture Parameters if the video capture application 
finds the Frame Grabber and begins synchronizing and tuning 
capture settings and image adjustments (see “Configuring 
image adjustments” on page 136 for more information).

• No Signal Detected if the video capture application cannot 
connect with the Frame Grabber or if the Frame Grabber is not 
connected to an active video source.

If the video capture application successfully connects to and 
synchronizes with the Frame Grabber, the video capture 
application window begins displaying captured images. 
Figure 13 shows the parts of the video capture application 
window.

Note: You use command line options to control some settings 
when the video capture application starts. For example, you can 
start the video capture application without any window borders 
and so that it always appear on top of all application windows. 
See “Windows command line options” on page 149.

Title Bar Displays the product name and serial number of the 
Frame Grabber that the video capture application is 
receiving captured images from. The title bar also 
displays the screen resolution and refresh rate of the 
video source. (The serial number is used for Web 
Broadcasting, see Chapter 16. “Web Broadcasting” 
on page 121.)

Menu Select commands from video capture application 
menus. See “Menus” on page 61.

Toolbar Save, print, and copy a snapshot of the current 
captured image. Start, stop, pause and resume 
recording images. Start and stop a web 
broadcasting session. See “Toolbar” on page 67.
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Common procedures
This section describes many of the most common video capture 
workstation procedures.

• Pausing, copying, saving, and printing images
• Recording captured images
• Starting web broadcasting

Pausing, copying, saving, and printing images
Once the video capture application is displaying images captured 
by the Frame Grabber, you can pause, copy, save, and print the 
current image.

To pause and resume the captured image

1 Select Pause from the Capture menu or from the toolbar select 

.

While the captured image is paused the video capture 
application stops receiving new images from the Frame 
Grabber. Pause also pauses video recording, image recording 
and web broadcasting. While paused you can save, print, and 
copy the captured image.

Captured 
Image

The image currently being captured by the Frame 
Grabber. The captured image is the same as the 
image that you can save, print, copy, and record.

Status Bar The status bar displays information about the 
current operation of the video capture application. 
The information displayed includes the file name of 
the video or image file last saved if the video 
capture application is recording video or image 
files. Other information includes whether sharing 
(web broadcasting) is on or off, the current frame 
rate, the number of frames captured, and the screen 
resolution and refresh rate of the video source. See 
“Status bar” on page 68.
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2 To resume capturing images select Pause from the Capture 

menu or from the toolbar select .

To copy a snapshot of the current image

You can use the following procedure to copy the image currently 
displayed by the video capture application to the video capture 
workstation clipboard. You can optionally pause image capture 
before copying an image.

1 Select Copy from the Edit menu or from the toolbar select .

The current image is copied to the clipboard. 

2 Paste the image into a document or other application as a 
bitmap image.

The image is pasted as a device independent bitmap image.

To save a snapshot of the current image as an image file

You can use the following procedure to save the current image as 
a bmp, png, or jpg file on the video capture workstation. You can 
optionally pause image capture before saving an image.

1 Select Save from the File menu or from the toolbar select .

The status bar shows the location and name of the saved file.

The first time you save an image the Save As dialog appears 
and you can specify the file name, file type, and location of the 
saved image file.

When you select Save again, the video capture application 
saves the new image with the same file name and location, 
overwriting the previously saved file. You can select Save As 
to save the image with a different file name, file type, and 
location.

You can open the saved image file with most bitmap image 
editing applications.
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To print a snapshot of the current image

You can use the following procedure to print the current image 
on any printer that is connected to the video capture workstation. 
You can optionally pause image capture before printing an 
image.

1 Select Print from the File menu or from the toolbar select .

The current image is sent to the default printer. You can select 
Print Setup from the file menu to select a different printer and 
set printer options.

Note: You can also configure the video capture application to 
invert colors for printing. From the Tools menu select Options 
then select the Display tab and select Invert colors for printing.

Recording captured images
You can record captured images as a video file or as a series of 
saved image files. In both cases the recording steps are the same.

To record captured images as a series of image files

Before recording captured images as a series of image files, you 
must configure recording options by selecting Options from the 
Tools menu, selecting the Recording tab, and selecting Record as 
Images. You should also select the image file format and other 
image file settings. See Chapter 14. “Recording image files” on 
page 91 for the details.

1 Select Start Recording from the Capture menu or from the 

toolbar select .

As images are captured by the Frame Grabber they are 
recorded as a series of image files according to the image file 
settings on the Recording tab of the Options dialog. The Status 
bar shows the name and location of the last saved file.

You can pause recording by selecting Pause from the Capture 

menu or  from the toolbar.
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You can stop recording by selecting Stop Recording from the 

Capture menu or  from the toolbar. 

When you stop recording images, the status bar displays the 
number of image files saved. For example, the message Wrote 
31 files. indicates the video capture application saved 31 
image files.

To record captured images as a video file

Before recording captured images as a video file you must 
configure recording options by selecting Options from the Tools 
menu, selecting the Recording tab, and selecting Record as Video. 
See Chapter 15. “Recording videos” on page 97 for all the details.

1 Select Start Recording from the Capture menu or from the 

toolbar select .

2 Enter the file name, select the location for saving the video file, 
and select Save.

As images are captured by the Frame Grabber they are 
recorded to the video file. The status bar shows the name and 
location of the video file. The status bar also displays the 
amount of time that the video has been recording and the 
number of frames (or images) recorded. 

When the size of the video file reaches the AVI file size limit 
(see “AVI file size limit” on page 103) the video capture 
application does one of the following:
• stops recording
• starts a new video file and continues recording 

(“Configuring video file recording options” on page 102 
describes how to specify the file name)

• overwrites the original video file and continues recording.

You can pause recording by selecting Pause from the Capture 

menu or  from the toolbar.
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You can stop recording by selecting Stop Recording from the 

Capture menu or  from the toolbar. 

When you stop recording, the Status bar shows the name and 
location of the saved video file, the amount of time that the 
video file was recording, and the number of frames (or images) 
recorded. For example: Wrote c:\temp\example.avi (85 sec, 
464 frames).

Starting web broadcasting
Before broadcasting captured images over the Internet you need 
to set the display format to 24 bits per pixel. See Chapter 16. “Web 
Broadcasting” on page 121 for more information about setting up 
web broadcasting.

To broadcast captured images over the Internet

1 Select Web Broadcasting from the Tools menu or from the 

toolbar select .

The Start web broadcasting dialog appears.

2 Record the Internet address from which users can view the 
web broadcast.

The address is always http://www.vga2usb/ followed by the 
serial number of the Frame Grabber capturing the broadcasted 
images. In the example above the Internet address is 
http://www.vga2usb.com/V2U15100.
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3 Select Start Web Broadcasting.

As images are captured by the Frame Grabber they are 
broadcast over the Internet. The Status bar displays 
SHARING ON. 

Users can use any web browser to connect to the Internet 
address to view the broadcast. See Chapter 16. “Web 
Broadcasting” on page 121 for more information about the 
system requirements for viewing web broadcasts.

You can pause web broadcasting new images by selecting 

Pause from the Capture menu or  from the toolbar.

You can stop web broadcasting by selecting Stop Web 

Broadcasting from the Tools menu or  from the toolbar. 
When you stop web broadcasting the status bar displays 
SHARING OFF.

Menus
This section describes the commands available from the following 
Windows video capture application menus:

• File menu
• Edit menu
• View menu
• Capture menu
• Tools menu
• KVM menu
• Help menu

File menu
Use the File menu commands to save and print the current image 
displayed by the video capture application and to exit the video 
capture application.
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Save Save a snapshot of the current image to a file on the 
video capture workstation. Select a location for the file 
and select a file format. You can save the snapshot as a 
bitmap (*.bmp), portable network graphics (*.png), or 
JPEG (*.jpg) file.

The first time you select Save after starting the video 
capture application you are prompted for a file name 
and you can change the file location and format. After 
saving the first file, every time you select Save the 
video capture software saves a snapshot using the 
same file name in the same location, replacing the 
previously saved file. When you select Save the status 
bar shows the location and name of the saved file.

Save As Save a snapshot of the current image to a file on the 
video capture workstation. Using Save As you can 
enter a file name and select a file location and format.

Save As resets the file name, location, and file format 
used by the Save command and the Save snapshot 
toolbar button. When you select Save As the status bar 
shows the location and name of the saved file.

Print 
Setup

Configure printer settings used when you select the 
Print command or the Print snapshot toolbar button. 
You can also configure the video capture application 
to invert colors for printing. From the Tools menu 
select Options then select the Display tab and select 
Invert colors for printing. See “Configuring display 
options” on page 71.

Print Print a snapshot of the current image to the configured 
printer.

Exit Close and exit the video capture application.
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Edit menu
From the edit menu you can copy a snapshot of the current 
image.

View menu
Use the commands on the view menu to control the parts of the 
video capture application window that are displayed.

Copy Copy a snapshot of the current image to the video 
capture workstation clipboard. You can paste this image 
into a document or other application as a bitmap image.

Toolbar Change the size of the toolbar icons or hide the 
toolbar. You can select small, large, or huge icons. 
If the toolbar is hidden, select an icon size to 
display the toolbar.

Status Bar Enable or disable displaying the status bar.
Image Only 
(Esc to exit)

Change the video capture application to operate 
in image only mode. In image only mode the 
video capture application displays the captured 
image only. The window borders, toolbar, status 
bar and menu bar are not displayed. Scroll bars 
are displayed if required.

Image only mode can be useful for applications 
such as integrating the video capture application 
into a custom system. You can still use all of the 
video capture application shortcut keys to save 
and print images, start and stop recordings, and 
to exit from image only mode. See “Shortcut 
keys” on page 69. You can always press Alt+F4 to 
exit from the video capture application.

You can also use the --borderless command line 
option to start the video capture application in 
image only mode. See “Windows command line 
options” on page 149 for information about this 
and other command line options.
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Capture menu
Use the commands on the capture menu to start, stop or pause 
capturing and recording images. From the capture menu you can 
also select the Frame Grabber that the video capture application 
receives captured images from if you have more than one 
Epiphan Frame Grabber connected to the video capture 
workstation. You can also override image adjustments, 
DirectShow settings, and the VGA mode settings for the selected 
Frame Grabber. 

The record functions on the capture menu record the current 
image as a video or as a series of consecutive image files. Select 
Options from the Tools menu and use the settings on the 
Recording tab to configure what the video capture application 
records. See “Recording, display, KVM and sharing options” on 
page 69.

Start 
Recording

Start recording the current image to a video file or 
a series of image files.

Stop 
Recording

Stop recording the current image.

Pause Pause or resume image capturing. If you select 
pause the video capture application stops 
displaying new captured images and the image 
captured when you selected Pause is displayed. 
Pause also pauses recording a video, pauses 
saving image files, and pauses web broadcasting. 
Select pause again to resume displaying captured 
images and resume recording or web 
broadcasting.

Select 
Device

If you have more than one Frame Grabber 
connected to the video capture workstation you 
can select Select Device to choose the Frame 
Grabber that the video capture application 
receives captured images from. You can also use 
this command to select the Frame Grabber to 
configure with the Configure Device command.
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Tools menu
Use the Tools menu to customize basic video capture application 
operating settings. The Tools menu also contains commands for 
special functions such as broadcasting captured images over the 
Internet.

KVM menu
Use the KVM menu if you are using the Epiphan KVM2USB 
Frame Grabber. See “Using the KVM2USB Frame Grabber” on 
page 129 for more information.

Configure 
Device

Override image adjustments, DirectShow options, 
and select VGA modes for the current Frame 
Grabber. See the following sections for more 
information:

• “Configuring image adjustments” on page 136
• “Configuring DirectShow options” on page 143
• “Configuring VGA modes” on page 145

Web 
Broadcasting

Broadcast the images being captured by the 
video capture application over the Internet. See 
Chapter 16. “Web Broadcasting” on page 121.

Upload EDID Use this command to upload an extended 
display identification data (EDID) file to your 
DVI2USB Frame Grabber. See “About EDID” on 
page 133.

Measure 
VGA Mode

When requested by Epiphan technical support, 
you can use this command to display low-level 
information about the VGA mode that you are 
capturing with your Frame Grabber. You can 
copy this information into an email to send it to 
Epiphan technical support.

Options Configure recording, display, KVM, and sharing 
(Internet Broadcasting) settings. See “Recording, 
display, KVM and sharing options” on page 69.
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Help menu
Use the Help menu to Check for Updates and to display 
information about the version of the video capture application 
that you are running.

Note: Check for Updates will only recommend an update if 
Epiphan recommends that you install a new version. This will 
happen if the latest version contains significant bug fixes or 
enhancements. If a new video capture application version only 
contains minor changes, Check for Updates may not recommend 
that you install a new version.

Figure 14:Displaying the video capture application version

Enter KVM 
Mode

Start operating the video capture application in 
KVM mode.

Reconnect 
KVM

Re-connect KVM mode if KVM stops functioning.

Send Ctrl-
Alt-Del

Simulate pressing Ctrl-Alt-Del on the Windows 
PC being managed by KVM. 
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Toolbar
Use the toolbar to save, print, or copy the current captured image, 
to start, pause, and stop recording the current captured image, 
and to start and stop web broadcasting. You can use the Toolbar 
command on the View menu to change the size of the toolbar 
icons or hide the toolbar. You can select small, large, or huge 
icons. If the toolbar is hidden, you can select an icon size to 
display the toolbar.

Save a snapshot of the current image captured by the 
video capture application to a file on the video capture 
workstation. Select a location for the file and select a file 
format. You can save the snapshot as a Windows bitmap 
(*.bmp), portable network graphics (*.png), or JPEG 
(*.jpg) file.
Print a snapshot of the current image to the configured 
printer.
Copy a snapshot of the current image to the video capture 
workstation clipboard. You can paste this image into a 
document or other application as a bitmap image.
Start or stop recording the images being captured by the 
video capture application as a series of image files or a 
video file. When you start recording the status bar 
displays RECORDING and also displays information 
about the image files or video file being recorded. When 
you stop recording the status bar displays information 
about the saved image files or video file.
Pause or resume image capturing. If you select pause, the 
video capture application stops displaying new captured 
images and the image captured when you selected Pause 
is displayed. Pause also pauses recording a video, pauses 
saving image files, and pauses web broadcasting. Select 
pause again to resume displaying captured images and 
resume recording or web broadcasting.
Start or stop broadcasting or sharing captured images 
over the Internet. See Chapter 16. “Web Broadcasting” on 
page 121.
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Status bar
The status bar displays information about the current status of the 
video capture application. The status bar contains the following 
number of sections:

• Four if the video capture application is just capturing images.
• Five if you are recording images.
• Six if you are recording images and you have selected Options 

from the Tools menu, selected the Display tab and selected 
Show frame count on the status bar. See “Configuring display 
options” on page 71.

These sections display the following information:

• The location and file name of image and video files saved 
while recording images. 

• The web broadcasting status. SHARING OFF means web 
broadcasting is turned off. SHARING ON indicates that web 
broadcasting is turned on.

• Recording status. RECORDING means that the video capture 
application is recording captured images.

• The frame rate that the Frame Grabber is operating at in 
frames per second (fps). For information about how the frame 
rate is determined, see “About the frame rate” on page 151.

• The number of frames that the Frame Grabber has captured 
since the video capture application was last started. The 
number of frames is only visible if you select Show frame 
count on the status bar from the Display tab of the Options 
dialog. See “Configuring display options” on page 71. The 
number of frames stops incrementing and starts flashing if 
you have paused the video capture application.

• The color depth and refresh rate of the captured images.
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Shortcut keys
You can use the following shortcut keys from the video capture 
application window.

Recording, display, KVM and sharing 
options

This section introduces the options available from the Tools menu 
when you select the Options command. These options control 
how the Frame Grabber and video capture application records 
images, displays images, triggers KVM, and shares or broadcasts 
images over the Internet.

Ctrl+S Save a snapshot of the current image to the 
video capture workstation. 

Ctrl+Shift+S Save As.
Ctrl+P Print a snapshot of the current image to the 

configured printer.
Ctrl+Shift+P Print Setup.
Ctrl+C Copy a snapshot of the current image to the 

clipboard.
Ctrl+R Start or stop recording images or video.
Ctrl+U Pause or resume image capturing.
Ctrl+W Start or stop web broadcasting.
Esc Exit Image Only mode.

Recording Configure how the video capture application 
saves captured frames when you start 
recording. You can record captured images as a 
series of image files or as an AVI video file. See 
“Configuring recording options” on page 70.

Display Configure the display format used by the video 
capture application for displaying and saving 
captured images. See “Configuring display 
options” on page 71.
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Configuring recording options
Select Options from the Tools menu and then select the Recording 
tab to control how the video capture application records captured 
images. You can record captured images as a series of 
consecutively saved graphic files or as a video file. How the video 
capture application records frames when you start recording 
from the Toolbar or the capture menu depends on how you set 
the recording options. You can select the following options.

KVM Configure the combination of keyboard and 
mouse events that switch KVM mode on and 
off. See “To set the KVM triggering event” on 
page 130.

Sharing Override default compression settings for web 
broadcasts. See “Changing web broadcasting 
compression and performance” on page 125.

Record as 
Images

Set the video capture application to record 
captured images as a series of image files saved 
on the video capture workstation. For 
information about how to record images and 
image recording settings, see 
Chapter 14. “Recording image files” on page 91.

Record as 
Video

Set the video capture application to record 
images as an AVI video file saved on the video 
capture workstation. For information about 
how to record videos and video recording 
settings, see Chapter 15. “Recording videos” on 
page 97.

Automatically 
turn 
recording off

Select automatically turn recording off to 
configure the video capture application to 
automatically stop recording captured images 
as image files or as a video file.
• You can stop recording after a specified 

number of images (frames) have been 
recorded. Set the number of frames in the 
range of 1 to 30,000. 

• You can stop recording after a specified time 
has elapsed. Set the time in seconds, 
minutes, or hours.
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Figure 15:Record as images options

Configuring display options
Select Options from the Tools menu and select the Display tab to 
select the display format that the video capture application uses 
to display and record captured images. As well you can use the 
display options to limit the frame rate that the video capture 
application uses. You can also enable or disable options that 
control how the video capture application displays and prints 
images.
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Figure 16:Display options

Display 
Format

Select the color depth that the video capture 
application uses to display, record, and print 
captured images. You can set display format to:
• RGB 24 bits per pixel
• RGB 16 bits per pixel
• RGB 8 bits per pixel
• Grayscale 256 levels
• Grayscale 32 levels
• Black and white
In most cases you should set the display format to 
RGB 24 bits per pixel. This setting is required for 
most video codecs, is supported by all image 
formats, and is required for web broadcasting.
For descriptions of display formats and color 
depths, see “Color depth, bits per pixel (bpp)” on 
page 45. For more information about setting the 
display format, see “About setting the display 
format” on page 74.
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Limit 
frame 
rate to

Select Limit frame rate to set a frame rate that is 
lower than the frame rate at which your Frame 
Grabber can capture images. You can reduce the 
frame rate to reduce the number of images captured 
by the Frame Grabber. You may want to reduce the 
frame rate to reduce the load on the video capture 
workstation, to reduce the size of recorded video 
files, or the number of saved image files.

For example, a VGA2USB LR or PRO can capture up 
to 60 frames a second (fps). This frame rate may 
approach 100% CPU usage, even on a dual CPU 
video capture workstation. To reduce load on the 
video capture workstation you can reduce the frame 
rate to 30 fps without losing very much useful data.

The valid frame rate range is from 0.01 to 60 fps. The 
default frame rate is 30 fps.

Resize 
window 
on 
resolution 
change

Select this option so that the video capture 
application resizes the application window when 
the resolution of the VGA or DVI source changes. 
This option does not affect recorded, printed, or 
saved images.

Fit image 
to 
window

Scale the displayed captured image up or down to 
fit in the video capture application window. This 
option does not change the size of recorded, printed, 
or saved images.

Invert 
colors for 
printing

This option is useful if you are printing images that 
contain light colored images, white text on a black 
background, or if for some other reason the printed 
image will be more useful if the colors are inverted. 
This option changes printed images only. It does not 
change the display and does not affect recorded or 
saved images.
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About setting the display format
For best results you would usually set the display format color 
depth to match the video source color depth. If the display format 
and video source color depth do not match, the device driver or 
video capture application converts the color resolution of images 
as they are captured. This conversion can put extra demands on 
the video capture workstation CPU.

Note: For a definition of color depth, see “Color depth, bits per 
pixel (bpp)” on page 45.

In some cases; however, you may want to set the display format 
to a different color depth than the video source. There are a 
number of possible reasons for doing this. For example:

• You are recording captured images to video and your video 
codec is not compatible with the color depth of the video 
source. In this case you could set the display format to match 
the requirements of your video codec.

• You want to save disk space. Setting display format to a lower 
color depth reduces the size of recorded image files or videos. 
Using a lower display format color depth means that the video 
and image files saved by the video capture application are 
smaller and use less disk space.

Flip 
image 
vertically

Select this option to turn the captured image 
displayed on the video capture application upside 
down. If you select this option, the image in 
recorded videos, the image that is copied when you 
select Copy from the Edit menu, printed images, 
and broadcasted images are also upside down. 
Images saved by selecting Save from the File menu 
and recorded image files are not affected by this 
option.

Show 
frame 
count on 
the status 
bar

Select this option to display on the status bar the 
total number of frames (or images) captured since 
the video capture application was last started.
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• You have special requirements for a color depth that is 
different from the color depth produced by the video source. 
Set the display format to the color depth that you require.

Epiphan Frame Grabbers capture images at the color depth of the 
video source up to the maximum color depth supported by the 
Frame Grabber. The maximum color depth supported by the 
VGA2USB Frame Grabber is 16 bits per pixel (bpp). The 
maximum color depth supported by all other Epiphan Frame 
Grabbers is 24 bpp.

Increasing the color depth of captured images
The VGA2USB Frame Grabber captures images at 16 bpp. If 
16 bpp is supported by the codec or image file format that you are 
using, you should also set the display format to RGB 16 bits per 
pixel. Setting the display format to RGB 24 bits per pixel requires 
the Frame Grabber device driver to convert the image format 
from RGB 16 to RGB 24. This results in extra CPU and memory 
usage and larger image or video files but the image quality (or 
amount of information) is still the same as in the original RGB 16 
images that came from the Frame Grabber. 
However, in most cases even with a VGA2USB Frame Grabber 
you would usually operate at 24 bpp because this color depth is 
required by most video codecs and also for web broadcasting. 
In most cases image capture and recording performance should 
be acceptable if the video capture workstation meets or exceeds 
the hardware requirements described in “Hardware 
Requirements” on page 11 and if there are not a lot of concurrent 
demands on this PC.
Reducing the color depth of captured images

All DVI2USB Frame Grabbers and the VGA2USB LR/HR/PRO 
Frame Grabbers can capture images at RGB 24 bpp. If your video 
source is operating at RGB 24 bpp and you set the display format 
lower than RGB 24 bpp, you are reducing the quality of the 
captured image. You are also causing the Epiphan USB device 
driver to consume extra CPU and memory resources to convert 
the images to the reduced color depth.
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However, in some cases you may choose to reduce the quality of 
the captured image for a number of reasons such as reducing file 
size, or a custom application that uses a different color depth. 
In most cases image capture and recording performance should 
be acceptable if the video capture workstation meets or exceeds 
the hardware requirements described in “Hardware 
Requirements” on page 11 and if there are not a lot of concurrent 
demands on this PC.

Converting color images to grayscale or black and white

If the Frame Grabber is capturing color RGB images and you set 
the display format to a grayscale or black and white format, the 
video capture application converts the color images to the 
requested grayscale or black and white format. Conversion from 
color to grayscale or black and white causes the greatest demand 
on the video capture workstation CPU because the conversion is 
performed by the video capture application. If you are capturing 
color images, you should only set the display format to grayscale 
or black and white if you have a specific need for this color depth. 
If you have concerns about performance, you can make some trial 
recordings to ensure the video capture workstation has sufficient 
CPU and memory resources.

Windows Epiphan USB device driver
On Windows video capture workstations the Epiphan USB device 
driver installs a VGA2USB control panel application (Figure 17).

You can use this control panel application to view the status of 
the Frame Grabber or Frame Grabbers connected to the video 
capture workstation. You can also select Configure Device to 
configure the following settings for each Frame Grabber that you 
have connected to the video capture workstation:

• Image adjustments, see “Configuring image adjustments” on 
page 136

• How the Epiphan USB device driver communicates with 
DirectShow, see “Configuring DirectShow options” on 
page 143
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• Customize or limit the VGA modes that the Frame Grabber 
can use, see “Configuring VGA modes” on page 145.

Figure 17:Epiphan USB device driver

Note: Changing these settings from this control panel has the 
same effect as selecting Configure Device from the Capture menu 
and changing the settings there.

Note: You can change and save configuration settings for any 
Frame Grabber that you have connected to the video capture 
workstation even if the Frame Grabber is not operating or 
connected at the time. If you change the configuration of a Frame 
Grabber that is not connected, the configuration is stored on the 
video capture workstation and applied to the Frame Grabber 
when the Frame Grabber is connected and operating.

You can also select Default Configuration to reset a Frame 
Grabber to its default configuration. Editing image adjustments 
and DirectShow options from the control panel application or 
from the video capture application has the same results.
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13.Mac OS X video capture 
application

This chapter describes common functions and features of the 
Epiphan video capture application for Mac OS X. You can use the 
Mac OS X version of the Epiphan video capture application to 
configure the Frame Grabber attached to your computer and to 
view, save, copy, and print the images captured by the Frame 
Grabber.

Note: For information about the Windows version of the Epiphan 
video capture application, see Chapter 12. “Windows video 
capture application” on page 51.

• For details about how to record video using the Mac OS X 
application HackTV Carbon, see “Recording videos for Mac 
OS X” on page 110.

• For details about how to set up KVM, see Chapter 17. “Using 
the KVM2USB Frame Grabber” on page 129.

• For many useful How To procedures see the How To page of 
the Epiphan Web Site.

This chapter assumes that you have followed the instructions in 
the Frame Grabber Installation Guide shipped with your Frame 
Grabber and also available as chapters 2 to 9 of this User Guide. To 
start using this chapter you should have:

• Selected a video capture workstation running Mac OS X that 
meets the system requirements described in your install guide 
and in Chapter 2. “System Requirements” on page 11. 

• Successfully installed the Epiphan USB device drivers, and 
video capture application on the video capture workstation as 
described in Chapter 4. “Installing the Mac OS X 
VGA2USB/DVI2USB drivers and application” on page 14.

• Connected your Frame Grabber to a VGA, DVI or dual-DVI 
source.

• Connected your Frame Grabber to a USB port on your video 
capture workstation.
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• If required you should have also connected power to the 
Frame Grabber.

Figure 18:Connecting Epiphan Frame Grabbers

This chapter describes:

• Upgrading to the latest Mac OS X software version
• Starting the Mac OS X video capture application
• Copying, saving, and printing images
• Menus
• Toolbar
• Changing system preferences

Upgrading to the latest Mac OS X 
software version

From time to time Epiphan makes new versions of all Epiphan 
Frame Grabber software available from the Epiphan web site. In 
most cases you can upgrade the Epiphan software on your Mac 
OS X video capture workstation by using normal procedures to 
download the latest version and install it without uninstalling the 
previous version.

Mac OS Video Capture
Workstation running
(Display, and Record

Captured images)

Video Source
(Equipment with VGA, DVI, or

Dual-DVI Output)

Epiphan
Frame Grabber

USB Cable

VGA, DVI or
Dual-DVI

Cable
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Note: Some versions of the Mac OS X Epiphan video capture 
application do not install a shortcut on the desktop. You can drag 
the Epiphan icon from the Applications folder to your desktop or 
add it to the Dock after installing a new version of the video 
capture application. You may also need to delete older versions of 
the Epiphan icon.

Finding software updates
To find the latest versions of all Epiphan software for Mac OS X, 
go to http://www.epiphan.com/downloads. You can also 
browse to the download page for your Frame Grabber product. 
For example, if you own an Epiphan VGA2USB Frame Grabber, 
you can browse to http://www.epiphan.com and select Products 
> VGA Frame Grabbers > VGA2USB > Download. 

On these download pages you will find the most recent version of 
this Epiphan Frame Grabber User Guide and the most recent release 
of the Epiphan device driver, QuickTime component and 
VGA2USB application compatible with MacOS X 10.4 and 10.5 
(Intel and PowerPC) and 10.3.

Starting the Mac OS X video capture 
application

Before starting the video capture application the Frame Grabber 
must be connected to the video capture workstation USB port. If 
required the Frame Grabber should also be connected to power.

Start the video capture application as you would any other 
application installed on the video capture workstation. 

As the application starts the following messages may appear on 
the video capture application window:

• Detecting Video Mode as the video capture application starts 
up and attempts to connect with the Frame Grabber.

• Tuning Capture Parameters if the video capture application 
finds the Frame Grabber and begins synchronizing and tuning 
capture settings and image adjustments (see “Configuring 
image adjustments” on page 136 for more information).
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• No Signal Detected if the video capture application cannot 
connect with the Frame Grabber or if the Frame Grabber is not 
connected to an active video source.

Figure 19:Epiphan video capture application window (Mac OS X, 
VGA2USB Frame Grabber)

If the video capture application successfully connects to and 
synchronizes with the Frame Grabber, the video capture 
application window begins displaying captured images. 
Figure 19 shows the parts of the video capture application 
window.

Title Bar Displays the product name of the Frame Grabber 
that the video capture application is receiving 
captured images from. The title bar also displays 
the screen resolution and refresh rate of the video 
source.

Title Bar

Toolbar

Captured
Image
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Copying, saving, and printing images
Once the video capture application is displaying images captured 
by the Frame Grabber, you can copy, save, and print the current 
image.

To copy a snapshot of the current image

You can use the following procedure to copy the image currently 
displayed by the video capture application to the video capture 
workstation clipboard.

1 Select Copy from the Edit menu or from the toolbar select .

The current image is copied to the clipboard. 

2 Paste the image into a document or other application as a 
bitmap image. 

To save a snapshot of the current image as an image file

You can use the following procedure to save the current image as 
a bmp, png, jpg, or tiff file on the video capture workstation.

1 Select Save from the File menu or from the toolbar select .

You can open the saved image file with most bitmap image 
editing applications.

Toolbar Save, copy, and print a snapshot of the current 
captured image. Switch to full screen mode, 
override image adjustments, and display 
information about the Frame Grabber. See 
“Toolbar” on page 89.

Captured 
Image

The image currently being captured by the Frame 
Grabber. The captured image is the same as the 
image that you can save, print, copy, and record.
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To print a snapshot of the current image

You can use the following procedure to print the current image 
on any printer that is connected to the video capture workstation.

1 Select Print from the File menu or from the toolbar select 

.

The current image is sent to the default printer. You can select 
Print Setup from the file menu to select a different printer and 
to set printer options.

Menus
This section describes the commands available from the following 
Mac OS X video capture application menus:

• VGA2USB menu
• File menu
• Edit menu
• View menu
• Tools menu

VGA2USB menu
Use the commands on the VGA2USB menu to view the current 
version of the video capture application, configure preferences 
for the video capture application, configure KVM preferences, 
and exit the video capture application.

About 
VGA2USB

Display the information about the version of the 
video capture application that you are running. 
See Figure 20.

Preferences Configure general preferences and KVM 
preferences for the video capture application. 

Quit 
VGA2USB

Exit the video capture application.
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Figure 20:Displaying the video capture application version

Video capture application general preferences
Configure video capture application preferences to set the video 
capture application to wide video mode or to limit the frame 
capture rate. To set preferences, select Preferences from the 
VGA2USB menu. 

Figure 21:General preferences

Wide 
video 
mode

This checkbox, when selected, allows Wide Aspect 
Ratio VGA modes to be displayed by the video capture 
application window. The Epiphan USB device driver 
may not be able to determine whether the video source 
is sending a wide video mode signal. You can select 
this option if your video source uses a wide video 
mode to make sure that the Epiphan USB device driver 
selects a wide video mode. You can also set this option 
using Mac OS X System Preferences. See “Setting 
QuickTime options for recording videos (Mac OS X)” 
on page 111.
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KVM preferences
Configure KVM preferences to enable KVM support and specify 
the event that starts KVM operation. 

To set KVM preferences, select Preferences from the VGA2USB 
menu and the select KVM from the Preferences toolbar.

Figure 22:KVM Preferences

Limit 
capture 
frame 
rate

Limit the capture frame rate to use the video capture 
application to control the capture frame rate. Specify a 
maximum number of frames per second. Usually you 
would only limit the frame rate in this way if the video 
capture workstation is having performance problems.

If you limit the capture frame rate, the video capture 
application records videos at the same rate as the 
limited frame rate. If the limited frame rate is higher 
than the frame rate of the Frame Grabber, the video 
capture application records videos at the frame rate of 
the Frame Grabber.
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File menu
Use the File menu commands to save and print the current image 
displayed by the video capture application.

Edit menu
From the edit menu you can copy a snapshot of the current 
image.

Enable KVM 
Support

Enable or disable KVM support. This option 
only takes effect when a KVM2USB Frame 
Grabber is connected to the video capture 
application. When KVM support is enabled the 
video capture application sends PS/2 events and 
with a KVM2USB Frame Grabber can be used to 
control a headless machine.

KVM Trigger 
Event

Select the key and mouse button combination 
that triggers switching between KVM mode and 
non-KVM mode.

Save 
Image

Save a snapshot of the current image to a file on the 
video capture workstation. Select a location for the 
file and select a file format. You can save the snapshot 
as a bitmap (*.bmp), portable network graphics 
(*.png), JPEG (*.jpg) file, or tiff (*.tiff) file.

Page 
Setup

Configure the printer settings used when you select 
the Print command or the Print toolbar button.

Print Print a snapshot of the current image to the 
configured printer.

Copy Copy a snapshot of the current image to the video 
capture workstation clipboard. You can paste this image 
into a document or other application as a bitmap image.
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View menu
Use the commands on the view menu to control the parts of the 
video capture application window that are displayed.

Tools menu
Use the Tools menu to select Show VGA Information to display 
low level information about the VGA mode that you are 
capturing with your Frame Grabber. When requested by Epiphan 
Support you can use this command and copy this information 
into an email to send it to Epiphan Support.

Figure 23:Viewing VGA information

Show Device 
Information

Enable or disable displaying information about 
the current Frame Grabber at the top of the 
video capture application window.

Show 
adjustment 
Controls

Override image adjustments. When the video 
capture application first starts, the application 
and the Frame Grabber adjust the captured 
image for optimal appearance. However, you 
may need to override these image adjustment 
settings to improve the image quality. See 
“Configuring image adjustments” on page 136.

Enter Full 
Screen

Scale the video capture application window to 
fill the screen.

Hide/Show 
Toolbar

Enable or disable displaying the toolbar at the 
top of the video capture application.
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Toolbar
Use the toolbar to save, copy or print the current captured image 
and to start, pause, or stop recording and to pause image 
capturing. You can use the Hide/Show Toolbar command on the 
View menu to show or hide the toolbar.

Save a snapshot of the current image captured by the 
video capture application to a file on the video capture 
workstation. Select a location for the file and select a file 
format. You can save the snapshot as a bitmap (*.bmp), 
portable network graphics (*.png), JPEG (*.jpg) file, or tiff 
(*.tiff) file.
Copy a snapshot of the current image to the video capture 
workstation clipboard. You can paste this image into a 
document or other application as a bitmap image.
Print a snapshot of the current image to the configured 
printer.

Full Screen mode. Scale the video capture application 
window to fill the screen.
Override Image Adjustments. When the video capture 
application first starts, the application and the Frame 
Grabber adjust the captured image for optimal 
appearance. However, you may need to override these 
image adjustment settings to improve the image quality. 
See “Configuring image adjustments” on page 136.
Device Info. Enable or disable displaying information 
about the current Frame Grabber at the top of the video 
capture application window.
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Changing system preferences
Before starting to record videos or to save or print images, you 
should configure Epiphan QuickTime integration options by 
opening System Preferences and selecting VGA2USB under Other 
and configuring QuickTime settings. See “Setting QuickTime 
options for recording videos (Mac OS X)” on page 111.

You can also select About to view information about the current 
software and driver versions.

Figure 24:System preferences about
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14.Recording image files
You can use the information in this chapter if you are planning on 
using your Epiphan Frame Grabber and Epiphan video capture 
application to record the images captured by your Frame Grabber 
as a series of individual image files. 

This chapter describes:

• Configuring image file recording options
• Setting display options to change how image files are recorded
• Recording image files
• Viewing saved image files

Configuring image file recording 
options

You should review and modify image file recording options 
before recording captured images as image files. Using image file 
recording options you can control the format of the image files, 
control the file naming system used for saving the image files, 
and determine whether to save all captured images or to be 
selective in the images that you capture.

To configure image file recording options

1 Start the video capture application.

2 On the Tools menu select Options.

3 On the Recording tab select Record Images.

4 Configure the following options and select OK or Apply to 
save your changes.
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Figure 25:Image file recording options

Format Select the file format for saving image files. You 
can choose BMP (Windows bitmap *.bmp), 
PNG (portable network graphics (*.png), or 
JPEG (*.jpg).

Filename 
generation

Use the filename generation options to control 
the names of the saved image files and the 
location on the video capture workstation to 
which to save the files.

Folder Type in the path to the folder or select the 
folder button to select the folder into which to 
save image files. All of the image files will be 
saved into this folder.

Prefix Enter a prefix to be added to the start of each 
saved image file name. All saved files will have 
the same prefix.
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Suffix Select a suffix for the end of each saved image 
file name. Use the suffix to automatically 
change the name of each saved file. You can 
select a number of different suffixes. Each one 
changes how the automatic file naming works. 
Each suffix starts with a % and can include the 
following characters:

• 02, 04, 06, or 08 indicates the number of 
digits to use in numbering the suffix. You 
can specify 2, 4, 6, or 8 digits.

• d means use decimal numbers in the suffix.
• X means use hexadecimal numbers in the 

suffix.
The suffix %02d means the saved file names 
would end with two-digit decimal numbers, 
for example: 01, 02, 03, ... 10, 11 and so on. The 
suffix %04X means the saved file names would 
end with 4-digit hexadecimal numbers, for 
example: 0001, 0002, 0003, ... 000A, 000B...

Start Enter the starting number used in the file name 
suffixes in decimal format. If the suffixes 
include hexadecimal numbering this decimal 
number is automatically converted to 
hexadecimal.

Example Displays an example file name constructed by 
the prefix and suffix that you have configured.

Overwrite 
existing files

If you select overwrite existing files, the video 
capture application saves files according to the 
image file recording options, overwriting 
existing files if any are present. 

If you do not select overwrite existing files, 
every time the video capture application 
encounters a file with the same name as it 
would have used to save the file it selects the 
next file name in the sequence until it can save 
a file without overwriting an already saved file.
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Save All 
Frames

Save all captured images during a recording 
session.

Skip Reduce the number of image files saved during 
a recording session. Save the first captured 
image at the start of a recording session but 
skip the specified number of captured images 
before saving the next image. Continue 
skipping the specified number of captured 
images between saving images. You can skip 
between 1 and 10,000 images.

Wait Save the first captured image at the start of a 
recording session but wait until the specified 
number of seconds, minutes, or hours has 
passed before saving the next image. Continue 
waiting the specified time period between 
saving captured images. Use this option to 
reduce the number of images saved during a 
recording session. You can set wait for up to 
10,000 hours.

Automatically 
turn recording 
off

Automatically stop recording images after a 
number of images have been recorded or a set 
amount of time has elapsed. You can turn 
recording off after between 1 and 30000 frames 
(or images) have been recorded. You can also 
turn recording off after a period of time that 
you set in seconds, minutes, or hours.
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Setting display options to change how 
image files are recorded

To change display options from the Tools menu, select Options 
and then select the Display tab. The following display options 
change how image files are recorded.

For more information about display options, see “Configuring 
display options” on page 71.

Recording image files
Before recording captured images as a series of image files, you 
should configure image recording options (see “Configuring 
image file recording options” on page 91) and optionally 
configure display format settings (see “Setting display options to 
change how image files are recorded” on page 95).

To record image files

1 Start capturing the images to be recorded.

2 Select Start Recording from the Capture menu or from the 

toolbar select .

As images are captured by the Frame Grabber, they are 
recorded as a series of image files according to the image file 
settings on the Recording tab of the Options dialog. The Status 
bar shows the names and location of image files as the video 
capture application saves them.

Display 
Format

The video capture application saves image files with 
the same color depth as the display format.

Limit 
frame 
rate to

If you limit the frame rate, the video capture 
application saves image files at the same rate as the 
limited frame rate. If the limited frame rate is higher 
than the frame rate of the Frame Grabber, the video 
capture application saves image files at the frame 
rate of the Frame Grabber.
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You can pause recording by selecting Pause from the Capture 

menu or  from the toolbar.

You can stop recording by selecting Stop Recording from the 

Capture menu or  from the toolbar. When you stop 

recording images the status bar displays the number of image 
files saved. For example, the message Wrote 31 files. indicates 
the video capture application saved 31 image files.

Viewing saved image files
The video capture application saves image files in the popular file 
formats that you can view using most bitmap graphics viewer or 
editor software programs. Figure 26 shows a saved image file 
named 640x480.png displayed using the GIMP bitmap graphics 
editor. You cannot use the Epiphan video capture application to 
view saved image files.

Figure 26:Viewing a saved image file using GIMP
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15.Recording videos
You can use the information in this chapter if you are planning on 
using your Epiphan Frame Grabber and Epiphan video capture 
application to record the frames captured by your Frame Grabber 
as video files.

This chapter describes:

• Recording videos for Windows 2000, XP, or Vista
• Using a DirectShow application to record video files
• Recording videos for Mac OS X
• Recording videos for Linux

Recording videos for Windows 2000, 
XP, or Vista

This section describes how to use the Epiphan video capture 
application to record video files on a video capture workstation 
running Windows 2000, XP or Vista.

Under Windows 2000, XP, or Vista, the Epiphan video capture 
application records videos as windows *.avi files. The *.avi files 
are created and saved by an external codec that must be installed 
on the video capture workstation. The Epiphan video capture 
application passes captured images to the video codec and the 
codec does the recording. Setting up video recording involves 
installing an external third-party video codec and adding that 
codec to your video capture application configuration. This 
section describes:

• Setting display options for recording videos
• Selecting a Windows video codec
• Installing the ffvfw video codec pack
• Configuring video file recording options
• Recording a video
• Playing back a video file
• Using a DirectShow application to record video files
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Setting display options for recording videos
Before starting to record videos, you should configure Epiphan 
video capture application display settings.

Note: Most video codecs require setting the display format to 
RGB 24 bits per pixel.

The following display options change how the video capture 
application records video files.

For more information about display options, see “Configuring 
display options” on page 71.

Selecting a Windows video codec
The video capture application automatically finds all of the video 
codecs installed on the video capture workstation. Unless you 
have already installed a high-speed codec, most of the codecs that 
the video capture application finds may be too slow or have poor 
compression. If a codec is too slow, the video recording frame rate 
may be too low to produce a good quality video without 
compromising the performance of the video capture workstation. 
If a video codec has poor compression, the recorded *.avi files 
could become very large.

Display 
Format

The video capture application records video files 
with the same color depth as the display format. 
Usually you need to set the display format to RGB 
24 bits per pixel before recording videos.

Limit 
frame 
rate to

If you limit the frame rate, the video capture 
application records videos at the same rate as the 
limited frame rate. If the limited frame rate is higher 
than the frame rate of the Frame Grabber, the video 
capture application records videos at the frame rate 
of the Frame Grabber.

Flip 
image 
vertically

Select this option to turn the captured image 
displayed on the video capture application upside 
down. If you select this option, the image in 
recorded videos is also upside down.
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To view the codecs installed on the video capture 
workstation

1 Start the Epiphan video capture application.

2 Select Options from the Tools menu.
3 Select the Recording tab.
4 Set Record as to Video.
5 Select the Select Codec button.
6 Select the Compressor list to view the list of video codecs 

available on the video capture workstation.

Figure 27:Example list of installed Windows video codecs

Although a number of codecs may be available, Epiphan 
recommends that you select a third-party codec to purchase or 
download that will meet your requirements. Select a video codec 
that can record videos at a high frame rate and that also supports 
high quality compression.
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Epiphan recommends the MS MPEG 4 V2 video codec for most 
applications. You can use this codec to produce *.avi files that are 
compatible with most *.avi players. This codec operates at high 
refresh rates without reducing the performance of the video 
capture workstation and also includes high quality compression.

Installing the ffvfw video codec pack
The MS MPEG 4 V2 video codec is available from the free ffvfw 
codecs pack. You can download the ffvfw codecs pack from 
http://www.free-codecs.com/download/ffvfw.htm.

To download and install the ffvfw video codec pack

1 Make sure the Display Format is set to RGB 24 bits per pixel.

Check by selecting Options from the Tools menu and selecting 
Display. See “Setting display options for recording videos” on 
page 98.

2 Select the following link to download the ffvfw codec pack:

http://www.free-codecs.com/Video_Codecs.htm

This link starts a download of the file ffvfw-20031028.exe, 
which is the installer for the ffvfw codec pack. Download this 
file and then run the executable (for example, double-click on 
the file) to install the ffvfw codec pack.

3 From the video capture application, select Options from the 
Tools menu.

4 Select the Recording tab.

5 Select Record as Video.

6 Select the Select Codec button.

7 In the Compressor list select ffvfw MPEG-4 Codec.

8 Select Configure.

9 Select the following settings for the ffvfw codec pack:
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10 You may not need to change other settings unless you have 
special requirements.

11 Select OK three times to save your changes.

Figure 28:Configuring the ffvfw codec pack

Encoder MS MPEG4 v2
FOURCC MP42
Mode one pass - quality
Quality Between 1 and 100. (Selecting a higher quality may 

reduce the frame rate and increase the size of the 
video files produced by the codec. You may want to 
experiment with the quality setting to achieve 
optimum results.)
ser Guide Page 101



15. Recording videos Recording videos for Windows 2000, XP, or Vista

P

Configuring video file recording options
You should review and modify video recording options before 
recording captured images as video files. Using video file 
recording options, you can control the maximum size of the video 
files (between 1 and 4095 Mbytes), and control the file naming 
system used for saving the video files.

Figure 29:Options for restarting recording

To configure video file recording options

1 Start the video capture application.

2 On the Tools menu select Options.

3 On the Recording tab select Record As Video.

4 Configure the following options and select OK or apply to save 
your changes.
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AVI file size 
limit

Select the maximum size of the video file that 
the video capture application can save. You can 
set the size to from 1 to 4095 Mbytes. During 
video recording, when the video file reaches this 
size limit a new file will be saved and recording 
will continue if you have selected Automatically 
restart recording. If you have not selected 
Automatically restart recording, video 
recording stops when the size limit is reached.

Automatically 
restart 
recording

If you select this option, a new file is created and 
recording continues each time the video file size 
limit is reached.

Overwrite the 
same file

After the video file size limit is reached, delete 
the original file and start recording a new video 
file with the same name. If you select this option 
the original saved video data is lost.

Create a new 
file every 
time 
recording is 
restarted

After the video file size limit is reached, start a 
new video file. You can use the append suffix to 
create a unique name for the new file or files.
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Append suffix When you start a video recording session you 
are prompted to enter a file name. If the file 
exceeds the AVI file size limit, the video capture 
application starts another file named with the 
original file name appended with a sequential 
numeric suffix. Use the append suffix options to 
specify format of this suffix. 

Each suffix starts with a % and can include the 
following characters:

• 02, 04, 06, or 08 indicates the number of 
digits to use in numbering the suffix. You 
can specify 2, 4, 6, or 8 digits.

• d means use decimal numbers in the suffix.
• X means use hexadecimal numbers in the 

suffix.
The suffix %02d means the saved file names 
would end with two-digit decimal numbers, for 
example: 01, 02, 03, ... 10, 11 and so on. The 
suffix %04X means the saved file names would 
end with 4-digit hexadecimal numbers, for 
example: 0001, 0002, 0003, ... 000A, 000B...

starting with Enter the starting number used in the file name 
suffixes in decimal format. If the suffixes 
include hexadecimal numbering this decimal 
number is automatically converted to 
hexadecimal. 

For example, if you named the video file VID, 
set the suffix to %02d and set starting with to 1, 
the video file names would be VID.avi, 
VID01.avi, VID02.avi and so on.
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Recording a video
Before recording captured images as a video you should:

• Set the display format to RGB 24 bits per pixel (see “Setting 
display options for recording videos” on page 98)

• Install and configure a video codec (see “Selecting a Windows 
video codec” on page 98 and “Installing the ffvfw video codec 
pack” on page 100) 

• Configure video file recording options (see “Configuring 
video file recording options” on page 102

• Review video recording options (see “Configuring video file 
recording options” on page 102).

To record captured images as a video file

1 Connect the Epiphan Frame Grabber to the video source that 
you want to record from and to the video capture workstation.

2 On the video capture workstation, start the video capture 
application.

3 Make sure the video capture application is displaying the 
captured images that you want to record. 

4 Select Start Recording from the Capture menu or from the 

toolbar select .

Overwrite 
existing files

If you select overwrite existing files the video 
capture application saves files according to the 
video file recording options, overwriting 
existing files if any are present. 

If you do not select overwrite existing files, 
every time the video capture application 
encounters a file with the same name as it 
would have used to save the file it selects the 
next file name in the sequence until it can save a 
file without overwriting an already saved file.
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5 Enter the file name, select the location for saving the video file, 
and select Save.

As images are captured by the Frame Grabber they are 
recorded to the video file. The Status bar shows the name and 
location of the video file. The status bar also displays the 
amount of time that the video has been recording and the 
number of frames (or images) recorded. 

When the size of the video file reaches the AVI file size limit, 
(see “AVI file size limit” on page 103) the video capture 
application does one of the following:
• stops recording.
• starts a new video file and continues recording. 

(“Configuring video file recording options” on page 102 
describes how to specify the file name.)

• overwrites the original video file and continues recording.

You can pause recording by selecting Pause from the Capture 

menu or  from the toolbar.

You can stop recording by selecting Stop Recording from the 

Capture menu or  from the toolbar. When you stop 

recording the Status bar shows the name and location of the 
saved video file, the amount of time that the video file was 
recording, and the number of frames (or images) recorded. For 
example: Wrote c:\temp\example.avi (85 sec, 464 frames).

Playing back a video file
Depending on the video codec that you used, you should be able 
to play back most recorded videos using Windows Media Player. 
If you are playing back the video file on a computer other than the 
video capture workstation, you may need to install a video codec 
on that computer.

You cannot use the Epiphan video capture application to play 
back video files.
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To play back a video file

1 Open the video file with a media player such as Windows 
Media Player.

2 Start, stop, pause, and view the video as required.

Using a DirectShow application to 
record video files

This section describes how to use the VirtualDub freeware 
application to capture images from an Epiphan Frame Grabber 
and record the captured images as *.avi video files. You can 
download and install VirtualDub from 
http://www.virtualdub.org/.

This is not a detailed description of how to use VirtualDub. This 
section provides a basic example of how to use a DirectShow-
compatible application to capture images using an Epiphan 
Frame Grabber. Even though these instructions are specific to 
Virtual Dub, you can apply them to any third-party video capture 
application that can get images from DirectShow. For more 
information about DirectShow, see “DirectShow” on page 37.

Epiphan Frame Grabbers communicate with VirtualDub using 
the DirectShow API. Any DirectShow-compatible image capture 
application installed on a video capture workstation that is 
connected to an Epiphan Frame Grabber can also receive 
captured images from the Frame Grabber.

The key to capturing images from an Epiphan Frame Grabber 
using a DirectShow-compatible capture application is to find the 
Frame Grabber from the capture application. To be able to find 
the Frame Grabber, you must install the Epiphan USB device 
driver on the video capture workstation and connect the Frame 
Grabber to the video capture workstation.
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If you have successfully installed the Epiphan USB device driver, 
when you connect an Epiphan Frame Grabber, the Frame 
Grabber’s name appears in the Windows Device Driver under 
Imaging Devices. For example, if you installed a DVI2USB Solo 
Frame Grabber, the name of the imaging device would be 
“DVI2USB Solo by Epiphan Systems Inc”.

You can also find the Frame Grabber from the Windows Control 
Panel by opening the Scanners and Cameras control panel 
application. The Frame Grabber has the same name in the 
Scanners and Cameras control panel application is in the 
Windows Device Driver.

From the Scanners and Cameras control panel application, you 
can right-click on the Epiphan Frame Grabber icon and select Get 
Pictures to save images captured by the Frame Grabber.

Before you start recording images with 
VirtualDub
You must have the following components before starting to 
record images using VirtualDub: 

• An Epiphan Frame Grabber.
• A VGA, DVI, or Dual-DVI video source.
• A video capture workstation running Windows 2000, XP, or 

Vista. See Chapter 2. “System Requirements” on page 11 for 
video capture workstation system requirements.

Use the following steps to download and install the required 
software and make the required connections before starting to 
record captured images using VirtualDub. 

1 Follow the steps in Chapter 3. “Installing the Windows 
VGA2USB/DVI2USB drivers and application” on page 12 to 
download and install the Epiphan USB device driver.

Unless you have developed your own USB device driver for 
Epiphan Frame Grabbers, you must install the Epiphan USB 
device driver, which is part of the VGA2USB/DVI2USB 
drivers and application. Windows and DirectShow can then 
get images from the Epiphan Frame Grabber.
age 108 Epiphan Frame Grabber



15. Recording videos Using a DirectShow application to record video files

U

2 Go to http://www.virtualdub.org/ and follow the 
instructions to download and install VirtualDub.

3 Optionally download and install a video codec such as the free 
ffvfw codec pack. You can download and install this codec 
pack from 
http://www.free-codecs.com/download/ffvfw.htm. Step 3 in 
the following procedure describes how to configure 
VirtualDub to use this video codec when recording captured 
images as a video file.

4 Connect your Epiphan Frame Grabber as described in the 
install chapters of this guide. 

For example, if you have a VGA2USB Pro Frame Grabber, see 
Chapter 5. “Connecting a VGA2USB Device” on page 16.

To record captured images as video files using VirtualDub

Now that you have downloaded and installed all the required 
software, the video source is producing images, and the Epiphan 
Frame Grabber is connected to the video source and the video 
capture workstation, you can use the following steps to record 
captured images as video files with VirtualDub.

1 Start the VirtualDub application.

2 From the File menu select Capture AVI.

VirtualDub changes to Capture mode.

3 From the VirtualDub Video menu select Compression.

4 Select the video codec to use for recording captured images.

For example, if you have installed the ffvfw codec pack you 
can select ffvfw MPEG-4 Codec. You can also configure the 
video codec from this dialog.

5 From the VirtualDub Device menu select your Frame Grabber.

For example, to record images from a VGA2USB Frame 
Grabber, select VGA2USB by Epiphan Systems Inc. 
(DirectShow).

After a short pause, the images being captured by the Frame 
Grabber appear in the VirtualDub window.
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6 From the VirtualDub File menu select Set Capture File and 
specify the name and location of the video file to be created 
when you start capturing images.

7 From the Capture menu select Capture Video to start 
recording captured images as an *.avi video file.

8 To stop recording, from the Capture menu select Stop Capture.

9 To exit capture mode, from the Capture menu select Exit 
Capture Mode.

Other configuration options
You can configure other VirtualDub options to control how 
VirtualDub records images. You can play back recorded videos 
from VirtualDub.

You can also use the VGA2USB Windows control panel 
application to configure image adjustments and DirectShow 
options for images captured and recorded by VirtualDub or any 
other DirectShow application. See “Configuring image 
adjustments” on page 136 and “Configuring DirectShow options” 
on page 143.

Recording videos for Mac OS X
This section describes how to use an application called HackTV 
Carbon to record video files on a video capture workstation 
running Mac OS X. To use HackTV Carbon you must first install 
the Epiphan USB device driver and Epiphan QuickTime 
component on the video capture workstation.

Apple QuickTime is the standard Mac OS X QuickTime 
multimedia API. The Epiphan capture API sends captured 
images to the Epiphan QuickTime component. The Epiphan 
QuickTime component sends the captured images to QuickTime 
where they can be recorded or otherwise processed by any 
QuickTime-compatible video recording application such as 
HackTV Carbon or QuickTime Pro.

This section describes:
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• Setting QuickTime options for recording videos (Mac OS X)
• Recording video files (Mac OS X)
• Playing back a video file (Mac OS X)

Setting QuickTime options for recording videos 
(Mac OS X)
Before starting to record videos you should configure Epiphan 
QuickTime integration options by opening System Preferences 
and selecting VGA2USB under Other and configuring QuickTime 
settings.

Figure 30:Mac OS X VGA2USB system preferences
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Video 
Resolution

Select a video resolution option:

Actual: The actual resolution of the video source is 
reported to QuickTime. If, at any point during a 
recording session, no signal is detected an error 
will occur that could interrupt the recording 
session.

Default: If a video signal has not been detected, the 
default resolution is reported and the video 
remains blank until the signal appears. If the 
default resolution does not match the actual 
resolution, images are resized to the default 
resolution.

Fixed: The same resolution is reported to 
QuickTime, regardless of the actual resolution of 
the image and whether or not a video signal is 
present. All images are scaled to the fixed 
resolution.

Default 
Frame 
Rate

Usually you can set the frame rate in the 
QuickTime-compatible video recording 
application. If you cannot set the frame rate in the 
application, set the default frame rate that the 
Epiphan USB device driver sends to QuickTime. 
This default frame rate is only used if the 
QuickTime video recording application does not 
explicitly set the frame rate.

Wide video 
mode

The Epiphan USB device driver may not be able to 
determine whether the video source is sending a 
wide video mode signal. You can select this option 
if your video source uses a wide video mode to 
make sure that the Epiphan USB device driver 
selects a wide video mode.
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Recording video files (Mac OS X)
Use the following procedure to record captured images as a video 
file using HackTV Carbon. This procedure assumes that you have 
installed the Epiphan USB device driver and the Epiphan 
QuickTime component on your Mac OS X video capture 
workstation as described in “Installing the Mac OS X 
VGA2USB/DVI2USB drivers and application” on page 14 and 
connected your Epiphan Frame Grabber as described in the 
install chapters of this guide. This procedure also assumes that 
you have downloaded and installed HackTV Carbon.

To record captured images as a video file

Note: Make sure you select Full Size from the HackTV Carbon 
Monitor menu to record full size video files.

1 Connect the Epiphan Frame Grabber to the video source that 
you want to record from and to the Mac OS X video capture 
workstation.

2 On the Mac OS X video capture workstation, start HackTV 
Carbon.

3 From the HackTV Carbon Monitor menu, select Video Settings 
and then Source.

4 Select the serial number of your Frame Grabber.

5 Select Compression and select a video codec such as MPEG-4 
Video.

6 Optionally adjust settings for the codec.

7 Select adjustments and configure adjustments as required.

8 From the Monitor menu select Full Size to record a full size 
image. 

You could also select other sizes if required.

9 From the Monitor menu select a recording option. Either 
Record without hogging machine or Record until mouseclick.

10 Specify the name and location of the video file to be created.
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Playing back a video file (Mac OS X)
You can play a QuickTime video using QuickTime or any 
QuickTime-compatible video player.

Recording videos for Linux
This section describes how to use the Epiphan USB device driver 
and Video4Linux to record video files on a video capture 
workstation running Linux. 

Video4Linux (V4L) is a Linux video capture API. The Epiphan 
USB device driver can send captured images directly to 
Video4Linux. This means that any Video4Linux-compatible 
application can receive captured images. You can use a 
Video4Linux-compatible application to record a series of 
captured images as a video in the video format supported by the 
application. 

This section describes:

• Recording video files (Linux)
• Playing back a video file (Linux)

Recording video files (Linux)
Use the following procedure to record captured images as a video 
file on a video capture workstation running Linux. This 
procedure assumes that you have installed the Epiphan USB 
device driver and Video4Linux and a video capture or recording 
application that is compatible with Video4Linux on your Linux 
video capture workstation. 

To download and install the latest version of the Epiphan USB 
device driver for your Linux distribution, browse to 
http://www.epiphan.com/products/ and locate the downloads 
page for your product. Scroll down to the Linux section of the 
downloads page.

This procedure also assumes that you have connected your 
Epiphan Frame Grabber as described in the install chapters of this 
guide.
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To record captured images as a video file

1 Connect the Epiphan Frame Grabber to the video source that 
you want to record from and to the Linux video capture 
workstation.

2 On the video capture workstation, start the Video4Linux-
compatible video capture or recording application.

3 Select your Frame Grabber as the video input.

For example, to record images from a DVI2USB Solo Frame 
Grabber, from the Video4Linux-compatible video capture or 
recording application you would select a video source with a 
name similar to DVI2USB Solo by Epiphan Systems Inc.

After a short pause the images being captured by the Frame 
Grabber appear in the Video4Linux-compatible video capture 
or recording application window.

4 Specify the name and location of the video file to be created 
when you start capturing images.

5 Start recording captured images as a video file using the 
format supported by the Video4Linux-compatible video 
capture or recording application.

Playing back a video file (Linux)
You can playback a saved video using a video player that can 
play videos in format of the video file created by the video 
capture or recording application.
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16.Web Broadcasting
You can use the information in this chapter to share or broadcast 
the images captured by your Epiphan Frame Grabber over the 
Internet. To broadcast captured images over the Internet, the 
video capture application sends captured images to an Epiphan 
web broadcasting portal. Each web broadcast session is labelled 
with the serial number of the Epiphan Frame Grabber that is 
capturing the images. The Frame Grabber serial number appears 
on the video capture application title bar.

Web broadcasting sends the currently captured image only. You 
cannot broadcast saved recordings and Epiphan Frame Grabber 
web broadcasting does not include sound.

Note: The Web Broadcasting feature included with the Epiphan 
video capture application is intended as a demonstration only 
and has a 5-minute time limit. You can contact Epiphan at 
info@epiphan.com to permanently enable the web broadcasting 
account for your Frame Grabber. This change is made on the 
Epiphan web broadcasting server and the change is not visible to 
the user.

Caution: The images broadcast over the Internet are not secure. 
Potentially anyone can view the web broadcast if they know the 
correct Internet address. The web broadcasting supported by the 
video capture application is a relatively limited feature. The 
Epiphan broadcasting products (such as VGA2WEB, VGA 
Broadcaster and VGA Bridge) provide a richer web broadcasting 
feature set.

This chapter describes:

• Setting the Display format for web broadcasting
• Starting a web broadcasting session
• Viewing a web broadcasting session
• Changing web broadcasting compression and performance
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Setting the Display format for web 
broadcasting

Before starting web broadcasting you must set the video capture 
application display format to RGB 24 bits per pixel.

To set the Display format for web broadcasting
1 Open the video capture application.
2 From the Tools menu select Options.
3 Select the Display tab.
4 Set Display Format to RGB 24 bits per pixel.
5 Optionally limit the frame rate to reduce the number of images 

sent over the Internet reducing the amount of bandwidth 
being used.
Depending on your requirements you may not have to change 
any other display settings. See “Configuring display options” 
on page 71.

6 Select OK to save your changes.
Figure 31:Configuring the display format
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Starting a web broadcasting session
No special setup is required for web broadcasting except that the 
video capture workstation must be able to connect to the Internet. 
The video capture workstation can be connected directly to the 
Internet or to a LAN that is connected to the Internet.

The following procedure is the same whether or not Epiphan has 
permanently enabled web broadcasting for your Frame Grabber.

To start a web broadcasting session

Before broadcasting captured images over the Internet you need 
to set the display format to 24 bits per pixel. 

1 Connect the Epiphan Frame Grabber to the video source that 
you want to broadcast and to the video capture workstation.

2 Start the video capture application.

3 Select Web Broadcasting from the Tools menu or from the 

toolbar select .

The Start web broadcasting dialog appears.
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4 Record the Internet address from which users can view the 
web broadcast.

The Internet address is always http://www.vga2usb/ 
followed by the serial number of the Frame Grabber capturing 
the broadcasted images. The serial number is visible in the 
video capture application title bar. In the example the Internet 
address is http://www.vga2usb.com/V2U15100.

The web broadcast internet address is not displayed by the 
video capture application during the broadcast.

5 Select Start Web Broadcasting.

As images are captured by the Frame Grabber they are 
broadcast over the Internet. The Status bar displays SHARING 
ON. 

Users can use any web browser and connect to the Internet 
address to view the broadcast. See “Viewing a web 
broadcasting session” on page 124 for more information about 
the system requirements for viewing web broadcasts.

You can pause web broadcasting by selecting Pause from the 

Capture menu or  from the toolbar.

You can stop web broadcasting by selecting Stop Web 

Broadcasting from the Tools menu or  from the toolbar. 
When you stop web broadcasting the status bar displays 
SHARING OFF.

Viewing a web broadcasting session
You can view a web broadcasting session from any web browser 
on any computer (Windows PC, Mac OS X, or Linux and so on) 
that can connect to the Internet. The PC and web browser should 
be running the most recent version of Java. You can download the 
latest version of Java from http://www.java.com.
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To view a web broadcast

1 Open a web browser and browse to the required Internet 
address, for example: http://www.vga2usb.com/V2U15100.

A second web browser window appears displaying the 
message Applet is loading. Please wait… The broadcasted 
image should appear within 10 to 20 seconds.

The first web browser window (in which the web broadcast 
address was entered) displays a message indicating that the 
web presentation has been opened in a new window. You can 
also use the first window to refresh the broadcast or re-open 
the broadcast window if it is accidentally closed. 

Changing web broadcasting 
compression and performance

Normally you would not need to change the default web 
broadcasting compression settings. The default settings reduce 
the amount of Internet bandwidth used for web broadcasting by 
applying a combination of lossless and lossy compression to the 
images being broadcast.

To change web broadcasting compression, from the Tools menu 
select Options and then select Sharing (Figure 32 on page 126). 
Select Override default compression settings and adjust the 
Lossless and Lossy settings.
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Figure 32:Web broadcasting compression options

Lossless 
compression

Lossless compression compresses the images 
being broadcast without reducing image 
quality. Increasing lossless compression can use 
a considerable amount of the video capture 
workstation CPU resources.

The default lossless setting is 5. The range is 1 
(Speed, the lowest lossless compression) to 9 
(Compression, the highest lossless 
compression). 

Lossy 
compression

Lossy compression compresses the images 
being broadcast by reducing image quality. 
Lossy compression is not as CPU intensive as 
lossless compression.

The default lossy setting is 75. The range is 10 
(Compression, the highest lossy compression 
and lowest quality) to 100 (Quality, the lowest 
lossy compression and the highest quality).
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Troubleshooting web broadcasting performance
Here are three typical reasons for adjusting web broadcasting 
compression:

• If you have a slow Internet connection or if receivers of the 
web broadcasts notice delays you can increase lossless or lossy 
compression to reduce Internet bandwidth usage. 

• If receivers of the web broadcast notice poor image quality 
you can reduce the amount of lossy compression. 

• If the video capture workstation CPU usage is too high during 
web broadcasts or if receivers of the web broadcasts notice 
delays and you have determined that the delays are not 
caused by low Internet bandwidth. The delays could be 
caused by high CPU usage on the video capture workstation 
resulting in the video capture workstation not being able to 
process all image data. Lossless compression increases CPU 
usage, so you can reduce CPU usage during web broadcasting 
by reducing lossless compression.

Note: You cannot change web broadcasting compression during a 
web broadcast. You must stop the broadcast, adjust the settings 
and then start the broadcast again.

Changes made to default web broadcast compression settings are 
only visible to viewers of the web broadcast. Changing these 
settings does not change how the video capture application 
displays, records, or prints captured images.

Some examples

Here are some examples of adjusting lossless and lossy 
compression for different Internet bandwidth and video capture 
workstation conditions.

• If the video capture workstation has a quad-core 3GHz CPU 
but connects to the Internet with a dial-up modem, you could 
move the lossless slider closer to Compression to increase the 
lossless compression to reduce Internet bandwidth usage.
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• If you have a high-bandwidth connection to the Internet but 
the video capture workstation has an older or relatively slow 
CPU (for example, a Pentium III CPU), you could move the 
lossless slider closer to Speed to reduce the lossless 
compression.

• If the video capture workstation has a relatively slow CPU and 
your Internet connection is relatively slow you can move the 
lossy slider closer to Compression to increase the lossy 
compression. 

• If increasing the lossy compression reduces image quality you 
can move the lossy slider closer to Quality to reduce the lossy 
compression and improve the quality of the image.

Improving performance by lowering the frame rate

You can also improve the performance of web broadcasting by 
lowering the frame rate. Lowering the frame rate reduces the 
amount of Internet bandwidth usage by reducing the number of 
frames broadcast. Lowering the frame rate also reduces the 
demand on the video capture workstation CPU resources 
(because fewer frames means the video capture workstation uses 
fewer CPU resources to capture and compress the frames). 

To lower the frame rate, from the Tools menu select Options and 
then select Display. Select Limit frame rate to and set the frame 
rate to a lower value.
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17.Using the KVM2USB Frame 
Grabber

Using the KVM2USB Frame Grabber you can use any 
administrator’s PC to connect to and operate a server that does 
not have a keyboard, monitor, and mouse. The KVM2USB 
operates like any keyboard, video, and mouse (KVM) system but 
the KVM2USB device is small and portable and requires simple 
connection and configuration settings.

You can use the KVM2USB for any operation on the headless 
server including interrupting boot up, selecting a different 
operating system, running the server in different operation 
modes (if supported by the server) and configuring the headless 
server BIOS settings.

You use a custom Epiphan cable to connect the KVB2USB device 
to the server. The custom cable connects to the mouse and 
keyboard ports using USB or PS/2 connections and to the VGA or 
DVI port of the server. The other end of the cable connects to the 
KVM2USB KVM input port. 

The KVM2USB USB connector connects to a USB port on the 
administrator’s PC. You also must install the Epiphan video 
capture application software on the administrator’s PC. The 
administrator’s PC can be running Windows or Mac OS X and 
must support USB 2.0.

Figure 33:Connecting the KVM2USB

Administrator’s
PC or laptop

Keyboard
Video

Mouse (KVM)

Headless
Server

USB Cable
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To set up KVM mode

On the administrator’s PC, use the following steps to start KVM 
mode after connecting the components.

1 Start the video capture application.

2 Optionally configure a KVM triggering event so that whenever 
you press a key sequence the video capture application starts 
KVM mode. See “To set the KVM triggering event”.

3 Start KVM mode:
• For Windows, from the KVM menu, select Enter KVM Mode.
• For Mac OS X, from the VGA2USB menu, select Preferences 

then select KVM and select Enable KVM Support.
• Use the KVM trigger event mouse and keyboard combination 

to start KVM mode.

The server’s display appears in the video capture application 
window.

To set KVM preferences for Windows, see “KVM menu” on 
page 65.

To set KVM preferences for Mac OS X, see “KVM preferences” 
on page 86.

4 Use the keyboard and mouse of the administrator’s PC to 
operate the server. The mouse and keyboard interaction with 
the server displays inside the video capture application 
window.

To set the KVM triggering event

1 Start the video capture application.

2 From the Tools menu select Options and select the KVM tab.
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Figure 34:Configuring the KVM triggering event

3 Select a keyboard key and mouse combination that you would 
like to use to start KVM operation.

Choose a combination that is not used by another application 
on the management PC or on the server. Setting a good KVM 
triggering event makes it easier and more efficient to enter and 
exit KVM mode. 

You can select the right, middle or left mouse button and any 
combination of the Ctrl, Alt, and Shift keys.

4 Select OK to save your changes.

To stop KVM mode

On the administrator’s PC video capture application from the 
KVM menu, select Exit KVM Mode or use the KVM triggering 
event. 
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18.Advanced topics
This chapter contains the following sections:

• About EDID
• Configuring image adjustments
• Configuring DirectShow options
• Configuring VGA modes
• Windows command line options
• About the frame rate
• Troubleshooting

About EDID
Extended display identification data (EDID) is data provided by a 
video display device (usually a monitor) to describe its 
capabilities to a video source. The video source uses the EDID to 
determine the capabilities of the monitor and, therefore, to 
determine the resolution, color depth and other settings that the 
monitor will accept.

EDID is defined by a standard published by the Video Electronics 
Standards Association (VESA). The EDID includes manufacturer 
name, product type, phosphor or filter type, timings supported 
by the display device, display size, luminance data and (for 
digital displays only) pixel mapping data. EDID is crucial for DVI 
sources but mostly ignored by VGA sources.

When you connect an Epiphan Frame Grabber to a video source, 
the video source sees the Frame Grabber as a monitor. Just like a 
monitor, the Frame Grabber contains EDID that is used by the 
video source to determine the video signal to send to the Frame 
Grabber.
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Figure 35:Frame Grabber EDID and video source

Usually you would operate an Epiphan Frame Grabber using the 
factory installed default EDID. However, in some cases when you 
connect an Epiphan Frame Grabber to a video source, the video 
source may operate using video settings that you do not want it to 
operate at.

For instance, you can control the video source output settings by 
uploading a custom EDID file to the Frame Grabber. The EDID 
information in the file restricts the video signal that can be 
accepted by the Frame Grabber. For example, you can upload a 
custom EDID file to your Frame Grabber that reports that the 
Frame Grabber only operates at 1040x768. When the video source 
reads the EDID from the Frame Grabber, the video source will 
reset to operate at 1024x768 as set in the EDID.

You can obtain custom EDID files from Epiphan Support. You 
can also download custom EDID files for DVI2USB frame 
grabbers from the DVI2USB, DVI2USB Solo, DVI2USB Duo 
EDIDs page of the Epiphan web site. This page contains custom 
EDIDs for single video resolutions (for example, 640x480 only, 
800x600 only, and 1024x768 only) for each DVI2USB Frame 
Grabber. This page also contains default EDIDs for each 
DVI2USB Frame Grabber. You can use the custom EDIDs to 
restrict the video resolution of the video source connected to the 
DVI2USB Frame Grabber. You can use the default EDIDs to 
return your DVI2USB Frame Grabber to normal operation.

Video Capture
Workstation

Video Source

Read by
video source

Uploaded to
Frame Grabber

Epiphan DVI
Frame Grabber

Video
cable

EDID
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Changing the EDID on your Frame Grabber
Use the following steps to upload a new EDID to your Frame 
Grabber. The uploaded EDID is permanently installed in the 
Frame Grabber and the Frame Grabber will always share this 
EDID with the video source.

1 Download an EDID file from the Epiphan web site or obtain an 
EDID file from Epiphan Support.

2 Disconnect the DVI cable from the Frame Grabber.

Keep the Frame Grabber connected to the video capture 
workstation USB port.

3 From the video capture application Tools menu, select Upload 
EDID and select the EDID file.

4 Wait for the EDID update to complete.

This can take several minutes.

5 Reconnect the DVI cable to the Frame Grabber.

6 Set the required resolution on the video source.

You may need to disable/re-enable or reset the DVI port. How 
you do this depends on your DVI source but could involve 
restarting the device, entering a reset command, or pressing a 
reset button. 

EDID example
In this example, a user was viewing the video output from a 
system using a flat panel monitor. The monitor displayed video 
images at a screen resolution of 640x480. When the user replaced 
the flat panel monitor with an Epiphan Frame Grabber, the 
system changed to produce video images at a screen resolution of 
720x400. 

It turned out that the video source preferred to output 720x400, 
but because the original monitor did not support 720x400, the 
video source was forced to operate at 640x480. The Frame 
Grabber supported 720x400 so the system changed to this 
resolution when the Frame Grabber was connected to it.
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The user wanted to return the video source to operating at 
640x480 but could not manually adjust the screen resolution. To 
solve the problem, Epiphan created a custom EDID for the Frame 
Grabber that excluded support for 720x400. When the user 
uploaded the custom EDID to the Frame Grabber, the video 
source returned to operating at 640x480.

Configuring image adjustments
On Windows, from the Capture menu you can select Configure 
Device and then select the adjustments tab to configure image 
capture adjustments. 

You can also configure image adjustments from the VGA2USB 
control panel application. See “Windows Epiphan USB device 
driver” on page 76.

Figure 36:Windows image capture adjustment options
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You can also use command line options to override automatic 
image adjustments. See “Windows command line options” on 
page 149.

On Mac OS X, from the View menu you can select Show 
Adjustment controls or from the Toolbar you can select the 
Adjust icon to configure basic and advanced capture adjustments. 

Figure 37:Mac OS X basic image capture adjustment options

Figure 38:Mac OS X advanced image capture adjustment 
options
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The video capture application automatically adjusts image 
capture settings every time it starts up. This image adjustment is 
also repeated every 60 seconds during operation. So normally 
you would not have to configure image capture adjustments. 
However, you may have special requirements or for other reasons 
have image quality problems that can only be fixed by making 
image adjustments.

If image adjustments are required, you should make them in 
small increments to avoid loss of image synchronization. If image 
synchronization is lost, the video capture application will stop 
capturing images. To start capturing images again you need to 
exit from and restart the video capture application.

Note: Because image adjustments are made automatically there 
are no default image adjustment settings. Also, changing image 
adjustments means making relative adjustments from the settings 
auto configured by the system.

Sampling Phase 
Adjust the sampling phase to change the horizontal resolution of 
the image. In Figure 39, the sampling phase is properly adjusted 
for Image A and the sampling phase for Image B is incorrectly 
adjusted. As a result Image B is not as clear as Image A.

If the image in the video capture application window displays a 
similar quality of image as shown in Image B, then select and 
adjust the sampling phase in small steps until a sharper image is 
displayed in the video capture application window.
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Figure 39:Adjusting the Sampling Phase

PLL adjustment 
The PLL adjustment adjusts the vertical synchronization 
properties of the image. In Figure 40, if the image in the video 
capture application window displays a similar quality of image as 
shown in Image D, then select and adjust the sampling phase in 
small steps until a sharper image is displayed in the video capture 
application window.
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Figure 40:PLL adjustment

A good indication that the PLL setting needs to be adjusted is 
when there is a repetitive distortion or blurriness on the 
horizontal axis of the image as shown in Image C and Image D 
above.

Horizontal and Vertical Shift 
Using the horizontal and vertical shift adjustments you can offset 
the image position on the screen. For example, Image E in 
Figure 41 shows a captured image shifted slightly to the right 
(horizontally) and slightly downward (vertically). To correct the 
image position, minor adjustments to these settings are necessary.
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Figure 41:Horizontal and Vertical Shift

Increasing or decreasing the Horizontal setting will cause the 
image to be shifted to the left or right respectively. Increasing or 
decreasing the Vertical setting will cause the image to be shifted 
upward or downward respectively.

Offset and Gain Controls (brightness/contrast)
The offset and gain settings control the image brightness and 
contrast respectively. Increasing the offset control causes the 
image to become darker. Increasing the Gain control gives the 
image more contrast.
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Prefer wide (16:9) VGA modes
This checkbox, when enabled, allows Wide Aspect Ratio VGA 
modes to be displayed by the video capture application window. 
The Epiphan USB device driver may not be able to determine 
whether the video source is sending a wide video mode signal. 
You can select this option if your video source uses a wide video 
mode to make sure that the Epiphan USB device driver selects a 
wide video mode.

Resetting image adjustments
Use the following procedure to turn off image adjustments 
settings so that image adjustments can return to being set 
automatically.

To reset image adjustments

1 Start the video capture application.

2 From the Capture menu select Configure Device.

3 Select the Adjustments tab.

4 Disable all types of image adjustments by clearing all 
checkboxes. 

5 Select OK.

6 Close the video capture application. 

7 Disconnect the USB cable from the video capture workstation 
or from the Frame Grabber and wait at least 10 seconds.

8 Reconnect the USB cable. 

9 Start the video capture application. 

Image adjustments are now set automatically again.
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Configuring DirectShow options
From the Capture menu you can select Configure Device and 
then select the DirectShow tab to configure DirectShow options. 

You can also configure DirectShow options from the VGA2USB 
control panel application.

Figure 42:Configuring DirectShow options

Fix 
Resolution

Control the image resolution reported to 
DirectShow and so used by DirectShow-
compatible applications. You can use this option to 
cause DirectShow to expand or shrink the image 
recorded by DirectShow-compatible video capture 
applications. The available resolutions range from 
640 x 480 to 2560 x 1600. 
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Default 
Image

Select an image to be sent to DirectShow if the 
Frame Grabber is not sending images to the video 
capture workstation. This option replaces what 
would otherwise be a blank screen with a static 
image that would be captured by DirectShow-
compatible image capture applications.

Scaling If Fix Resolution is set to a resolution that does not 
match the actual resolution of the video signal you 
can select Pixel Resize to have the Epiphan USB 
device driver resize the image (either shrink or 
expand it) to match the fixed resolution. Pixel 
Resize is a simple resizing method that adds or 
removes pixels as required to resize an image.

If you set scaling to No Resizing the Epiphan USB 
device driver does not resize the image sent to 
DirectShow. If the actual resolution of the video 
signal is smaller than the fixed resolution, the 
image appears in DirectShow compatible video 
capture applications with a border around it. If the 
actual resolution is larger than the fixed resolution, 
the image appears cropped in DirectShow 
compatible video capture applications.

Flip image 
vertically

Select this option to turn the captured image 
displayed on the video capture application upside 
down. If you select this option, the image in 
recorded videos, the image that is copied when 
you select Copy from the Edit menu, printed 
images, and broadcasted images are also upside 
down. Images saved by selecting Save from the 
File menu and recorded image files are not affected 
by this option.
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Configuring VGA modes
For a description of VGA modes that also describes many of the 
terms used in this section, see “VGA modes” on page 48.

If you are capturing images from a VGA stream, from the Capture 
menu of the video capture application you can select Configure 
Device and then select the VGA modes tab to configure the VGA 
modes that the Frame Grabber can operate in. You can also 
configure VGA modes from the VGA2USB control panel 
application.

In most cases you should not have to configure VGA modes. 
Usually the Frame Grabber and VGA source can automatically 
select a VGA mode.

Limit 
frame rate 
to

Select Limit frame rate to and set a frame rate that 
is lower than the frame rate at which your Frame 
Grabber can capture images. You can reduce the 
frame rate to reduce the number of images 
captured by the Frame Grabber. You may want to 
reduce the frame rate to reduce the load on the 
video capture workstation or to reduce the size of 
recorded video files.

For example, if the Frame Grabber can capture up 
to 60 frames a second (fps), this frame rate may use 
close to 100% CPU usage on some video capture 
workstations. To reduce load on the video capture 
workstation you can limit the frame rate to 30 fps 
without loosing very much useful data.

The valid frame rate range is from 0.01 to 60 fps. 
The default frame rate is 30 fps.

Fix frame 
rate

Select fix frame rate to force the frame rate to 
always be the same as the limited frame rate. If the 
limited frame rate is less than the actual frame rate 
some frames will be missed. If the limited frame 
rate is higher than the actual frame rate some 
frames will be duplicated.
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However, configuring VGA modes can be useful if you have 
special requirements or if the VGA source and Frame Grabber do 
not automatically select the VGA mode that you want. To resolve 
problems like this you can configure VGA modes to either limit 
the standard VGA modes that the Frame Grabber can operate in 
or you can add one or more custom VGA modes and configure 
the Frame Grabber to operate in a custom VGA mode.

Figure 43:Configuring VGA Modes

The Frame Grabber acts like a display device. Many VGA sources 
set the VGA mode that they use by checking the VGA modes the 
display device can use and then setting their VGA output mode 
to match. So if you can control the VGA mode that the Frame 
Grabber uses you may be able to control the VGA mode that the 
VGA source uses.

If the Frame Grabber and the VGA source cannot automatically 
select the VGA mode that you want them to use, you may be able 
to resolve this by only allowing the Frame Grabber to operate in 
one or some standard VGA modes.
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If the VGA source operates in a non-standard VGA mode, you 
can use the custom VGA mode settings to add that non-standard 
mode to your Frame Grabber. The Frame Grabber can then 
operate in that mode. 

Adding custom VGA modes
Add custom VGA modes if you want your Frame Grabber to 
operate in a non-standard (custom) VGA mode. You may want to 
do this if your video source operates in a non-standard VGA 
mode. 

You can add as many custom VGA modes as you want for each 
Frame Grabber. If you want the Frame Grabber to operate with a 
single custom VGA mode, then just add one. You can add more if 
you need to operate your Frame Grabber in different custom 
VGA modes later. 

In most cases the Frame Grabber will automatically select the 
custom video mode that most closely matches the VGA output. If 
you want to make sure that a the Frame Grabber selects a specific 
custom video mode you can unselect all standard VGA modes 
and all custom VGA modes except for the one that you want the 
Frame Grabber to use. 

Usually you would configure a custom VGA mode to match the 
custom VGA mode of your VGA source. (So you do not need to 
understand the details of custom VGA modes to add them to 
your Frame Grabber.) The video capture application does not 
provide any guidance in configuring custom VGA modes. You 
can enter almost any value in any of the fields. So you need to 
know the details about the VGA mode settings of your VGA 
source then add that information to the custom VGA mode 
configuration. 

You can add, edit, and delete custom VGA modes. If you add 
multiple custom VGA modes you can select one or more for the 
Frame Grabber to use.
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To add a custom VGA mode to a Frame Grabber

1 Start the video capture application.
2 From the Capture menu, select Select Device.
3 Select the Frame Grabber to add a custom VGA mode to and 

select OK.
4 From the Capture menu, select Configure Device.
5 Select the VGA Modes tab.

6 Select  to add a custom VGA mode.
Figure 44:Adding a custom VGA mode

7 Configure the custom VGA mode with the following 
information:
• Refresh rate
• Select Interlaced if required
The following horizontal timings in pixels:
• Active area
• Front porch
• Sync time
• Back Porch
• Sync polarity (positive or negative)
The following vertical timings in pixels:
• Active area
• Front porch
• Sync time
• Back Porch
• Sync polarity (positive or negative)
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8 Select OK.

9 Make sure that the required custom VGA mode or modes are 
selected in the Custom VGA modes list.

Selecting standard VGA modes
A Frame Grabber can operate in over 80 different standard VGA 
modes. This list is designed to support as many popular standard 
VGA modes as possible. All of these VGA modes are listed in the 
Standard VGA Modes list on the VGA modes tab. You can use 
this list to control the standard VGA modes that the Frame 
Grabber can operate in by selecting or deselecting standard VGA 
modes in the list.

Windows command line options
You can use the following command line options to control how 
the Windows video capture application starts up. You can add as 
many command line options as you want in any order. All 
command line options must start with two dashes. Separate 
command line options with spaces. See “Creating a Windows 
shortcut that uses command line options” on page 150 for some 
examples.

--borderless Start the video capture application in image only 
mode. You can press Esc to exit from image only 
mode.

--sn <sn> To specify which Frame Grabber to use if more 
than one Frame Grabber is connected to the PC. 
Similar to the Capture menu Select Device 
command. <sn> is the serial number of the 
Frame Grabber.

--hs <#> Set the horizontal shift*. The range is -100 to 100.
--vs <#> Set the vertical shift*. The range is -80 to 80.
--phase <#> Set the sampling Phase*. The range is 0 to 31.
--pll <#> Set the PLL adjustment*. The range is -50 to 50.
--offset <#> Set the offset (brightness)*. The range is 0 to 63.
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Creating a Windows shortcut that uses command line 
options

You can use video capture application command line options by 
creating a Windows shortcut to the video capture application 
executable file and editing the shortcut to add command line 
options. In the following procedure, the video capture application 
executable file v2ugui2.exe has been installed in the folder 
C:\Program Files\VGA2USB DVI2USB KVM2USB\.

1 Open Windows Explorer and navigate the following path:

C:\Program Files\VGA2USB DVI2USB KVM2USB

2 Right click on the file v2ugui2.exe and select Create Shortcut.

Windows creates a shortcut file that, depending on your 
Windows settings, may be named “Shortcut to 
v2ugui2.exe.lnk”. The “.lnk” may not appear if Windows does 
not display file extensions. You can change the name of this 
file and copy it to another location if required. Don’t change 
the file extension.

3 Right click on the shortcut file and select Properties.

--gain <#> Set the gain (contrast)*. The range is 0 to 255.
--noesc Enter this parameter so that you can disable 

exiting image only mode by Pressing the Esc 
key. You can always press Alt+F4 to exit from 
the video capture application.

--topmost To keep the video capture application window 
on top.

*See “Configuring image adjustments” on page 136.
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4 Edit the Target field and add command line options after the 
closing quote.

For example, to add the --topmost command line option:
"C:\Program Files\VGA2USB DVI2USB KVM2USB\v2ugui2.exe" --topmost

For example, to add --topmost and --borderless, set the 
horizontal shift to -67, and the vertical shift to 10:
"C:\Program Files\VGA2USB DVI2USB KVM2USB\v2ugui2.exe" --topmost 
--borderless --hs -67 --vs 10

5 Select OK to save your changes to the shortcut.

Double-click on the shortcut to start the video capture 
application with the command line options.

About the frame rate
The Frame rate at which your Frame Grabber and the video 
capture application operates depends on the resolution of the 
VGA or DVI source on the Frame Grabber that you are using, and 
on the video capture workstation hardware.

For Frame Grabbers that do not support hardware compression, 
performance and frame rate is limited mostly by USB throughput. 
The theoretical limit for USB 2.0 is 60 MB/sec and the practical 
limit for bulk transfers is between 20 and 40 MB/sec.

The theoretical maximum frame rate can be determined using the 
following calculation: 

theoretical maximum frame rate= (20000000/(n*w*h)) 

Where:

• w and h are the number of columns and rows in the video 
mode (for example, 800x600 or 1024x768).

• n is number of bytes per pixel (from 1 to 3, see below)

The real maximum frame rate is usually lower than the 
theoretical maximum frame rate because the real maximum frame 
rate is limited by the video capture workstation CPU and 
memory or by extra load on the USB bus (for example, if you have 
other USB devices on the same USB bus).
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For the VGA2USB Frame Grabber, n is always 2 (because the 
VGA2USB Frame Grabber maximum color depth is RGB16 which 
is 2 bytes per pixel).

For the DVI2USB Frame Grabber n can be from 1 to 3 depending 
on the capture mode. The DVI2USB Frame Grabber maximum 
color depth is RGB24 (3 bytes per pixel) as well as RGB16 (2 bytes 
per pixel) and RGB8/Grayscale (1 byte per pixel).

For Frame Grabbers that support hardware compression (the 
VGA2USB LR/HR/Pro, DVI2USB Solo/Duo) the maximum real 
frame rate very much depends on the entropy (statistical 
properties) of the input VGA or DVI signal. In other words, the 
frame rate depends on how well the signal can be compressed, or 
how much the next frame is different from the previous one. The 
frame rate can range, from less than non-compressing VGA2USB 
in the worst-case scenario (because the format for compressed 
data adds extra overhead) to 60 frames per second (hardwired 
limit) if almost nothing changes on the image.
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Troubleshooting
Some basic Frame Grabber troubleshooting tips:

Problem Possible cause Action to take

Nothing is 
displayed on 
local monitor

The VGA/DVI cables 
are not properly 
connected to either 
the Frame Grabber or 
to the VGA source 
equipment. 

Check that the 
VGA/DVI cables are 
properly connected. See 
the connection 
instructions for your 
Frame Grabber. For 
example: “To connect a 
VGA2USB (including 
LR, HR, and Pro)” on 
page 17.

Autosave is 
enabled, but 
there are no 
image files 
saved

Filename settings are 
not properly setup.

See the File Name 
Generation Settings 
described in 
“Configuring image file 
recording options” on 
page 91.

When Web 
Broadcasting 
is enabled, 
the following 
message 
appears: 
Sharing has 
been stopped

The Internet 
connection on the host 
computer is not 
functioning properly, 
or the time limit for 
the broadcasting 
session has been 
reached.

Verify that the network 
cable is properly 
connected to the host 
computer and then open 
a web browser window 
to verify that the internet 
connection is working.
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bmp 42
borderless

command line option 63
bpp 45
bridge

VGA 121

broadcast
captured images 60
changing compression 125
changing performance 125
connected to a LAN 123
images over the Internet 121
Internet address 124
Java 124
pause 64
pausing 124
setting the display format 

122
broadcasting

starting a session 123

C
capture 46

menu 64
turn off automatically 70

capture API 37
Linux 44
Mac OS X 41

captured image 56, 83
converting to black and 

white 76
converting to greyscale 76
copy 57, 83
increasing the color depth 75
pause 56
print 58, 84
record 58
record as image files 58
record as video file 59
recording as a video 105, 

113, 114
reducing the color depth 75
resume 56
save as an image file 57, 83
snapshot 57, 83
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changing
EDID 135

check for updates 53, 66
codec

configuring 100
installing 100
MS MPEG 4 V2 video codec 

100
selecting a Windows video 

codec 98
video 38
viewing installed codecs 99

color depth 72
converting to black and 

white 76
converting to grayscale 76
increasing for captured 

images 75
reducing for captured images 

75
See Also, bits per pixel 45
USB device driver 35

color resolution 47
See Also, color depth 45

command line option 63
common procedures 56
compression

changing for web 
broadcasting 125

frame grabber 32
lossless 126
lossy 126

compression for web broadcasting 
126

configuration
default 77

configure device 76
command 65

connecting a DVI2USB 18, 19
connecting a DVI2USB Duo 22, 23
connecting a DVI2USB Solo 20, 21
connecting a KVM2USB Solo 24, 

25
connecting a VGA2USB 17
connecting a VGA2USB device 16
connecting a VGA2USB HR 17
connecting a VGA2USB LR 17
connecting a VGA2USB Pro 17
control panel

VGA2USB 108
control panel application 36

USB device driver 36
Windows 76
Windows USB device driver 

76
copy

captured image 57, 83
image to the clipboard 63, 87

create a new file every time 
recording is restarted 103

cropping 32
Ctrl+C

shortcut key 69
Ctrl+P

shortcut key 69
Ctrl+R

shortcut key 69
Ctrl+S 69
Ctrl+Shift+P

shortcut key 69
Ctrl+Shift+S

shortcut key 69
Ctrl+U

shortcut key 69
Ctrl+W

shortcut key 69
Ctrl-Alt-Del

send 66
custom video capture applications

Linux 45
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D
default configuration 77
default frame rate

recording image files on Mac 
OS X 112

default image
DirectShow 144

detecting video mode 55, 81
device

configure 76
device information

show 88
Digital Visual Interface 47
DirectShow 34, 37

API 107
default image 144
fix resolution 143
options 143
override defaults 65
pixel resize scaling 144
recording video from 109
recording video using a 

DirectShow application 107
VirtualDub configuration 

options 110
display

options 69, 71
options for recording videos 

98, 111
display format 72

about 74
recording image files 95, 98
setting for web broadcasting 

122
DVI 47

video source 30
DVI2USB

connecting 18, 19
package contents 18

DVI2USB by Epiphan Systems Inc 
108

DVI2USB Duo
connecting 22, 23
package contents 22

DVI2USB Solo
connecting 20, 21
package contents 20

E
EDID

about 133
changing 135
upload 65, 135

Edit
menu 63

enable KVM support 87
enter KVM mode

command 66
Epiphan capture API 37
Epiphan USB device driver

kernel mode 34
upgrading 53, 80

example
image file name 93

exit
command 62

extended display identification 
data 65

F
ffvfw video codec pack

installing 100
File

menu 61
file name

example image file name 93
image file name prefix 92
image file name suffix 93
video file name suffix 104

filename generation
image file 92
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fit image to window 73
fix resolution

DirectShow 143
flip image vertically 74, 98, 144

recording videos 98
folder

image file 92
format

image file 92
fps 68
frame 47
frame count

show on the status bar 74
Frame Grabber

reset to default configuration 
77

frame grabber 30, 32, 47
frame rate 32
how they operate 32
lossless image compression 

32
maximum color depth 75
on-board cropping 32
pre-compression 32
serial number 55, 121

frame grabbing 46
frame rate

about 151
frame grabber 32
limit 73, 145, 151
limiting 86

frames per second 68
full screen 88

G
general preferences 85
getting started

Mac OS X 79
Windows 51

glossary 45
grayscale

See greyscale 46
greyscale 76

256 levels 46, 72
32 levels 46, 72

H
HackTV Carbon 41, 110
hard disk space 11
hardware requirements 11

hard disk space 11
processor speed 11
RAM memory 11
USB port 11

headless
server 129

Help
menu 66

hide
toolbar 88

high color 45

I
image

copy to the clipboard 63, 87
fit to window 73
flip vertically 74, 98, 144
paste 63, 87
save 62, 87

image adjustments 35, 65, 89
override 88

image capture 46
pause 64

image compression
lossless 32
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image file
automatically turn recording 

off 94
example file name 93
file name prefix 92
file name suffix 93
filename generation 92
folder 92
format 92
overwrite existing files 93, 

105
recording 91, 95
recording options 91
save a captured image 57, 

83
save all frames 94
start of file name suffix 93
viewing 96
wait 94

image only
borderless command line 

option 149
integrating with other 

applications 63
view 63

imaging devices
DVI2USB by Epiphan 

Systems Inc 108
installing 12, 14
integrating with other applications

image only mode 63
Internet

broadcasting images 121
Internet address

web broadcast 124

invert colors for printing 58, 73

J
Java 124
jpeg 42

K
kernel mode 34

USB device driver 34
KVM

enable KVM support 87
menu 65
preferences 86
trigger event 87
triggering event 130

KVM2USB 65
BIOS settings 129
package contents 24
using 129

KVM2USB Solo
connecting 24, 25

L
LAN

web broadcasting 123
LEDs

VGA2USB 27
limit capture frame rate 86
limit frame rate to 73, 145

recording image files 95, 98
recording videos 98

Linux 34, 42
capture API 44
custom video capture 

applications 45
recording a video 114
recording videos 114
USB device driver 43
video capture workstation 42

loseless
See lossless 126
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lossless 126
lossless image compression 32
lossy 126

M
Mac OS X

capture API 41
getting started 79
installing the VGA2USB/

DVI2USB drivers and 
application 14

preferences 84
QuickTime 34
recording a video 113
recording videos 110
USB 2.0 ports 26
USB device driver 40
VGA2USB/DVI2USB drivers 

and application 14
video capture application 42
video capture application 

version 85
measure VGA mode

command 65
memory

RAM 11
menu 55, 61

capture 64
Edit 63
File 61
KVM 65
Tools 65
View 63

message
applet is loading. please wait 

125
wrote files 59, 96

millions of colors 45
mode

configuring VGA modes 145

MS MPEG 4 V2 video codec 100

N
no resizing

DirectShow scaling 144
no signal detected 55, 82

O
options

command 65
override 65, 89
overwrite existing files

image file 93
video file 105

overwrite the same file 103

P
page

setup 87
page setup

command 87
paste

paste copied image 63, 87
pause

captured image 56
image capture 64
web broadcast 124

performance
changing for web 

broadcasting 125
frame rate 151
lowering frame rate 128
troubleshooting web 

broadcasting 127
pixel resize 144
play

video 106, 114, 115
png 42
pre-compression

frame grabber 32
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preferences
general 85
KVM 86
Mac OS X 84

prefix
image file 92

Print 87
print 62

captured image 58, 84
invert colors 73
invert colors for printing 58
setup 62

print setup
command 62

printer
settings 62, 87

procedures
common 56

processor speed 11

Q
QuickTime 34

Epiphan QuickTime 
component 41

QuickTime component
upgrading 80

QuickTime Pro 41

R
RAM memory 11
reconnect KVM

command 66

record 48
avi 97
captured images from 

DirectShow 109
captured images using 

VirtualDub 109
video 105, 113, 114
video from DirectShow 109
video using a DirectShow 

application 107
video using VirtualDub 109
videos 97
videos for Linux 114
videos for Mac OS X 110
videos for Windows 97
videos for Windows Vista 97
videos for Windows XP 97

record as images 58
captured image 58

record as video file
captured image 59

record images
Scanners and Cameras 

control panel application 
108

record video
display options 98, 111
flip image vertically 98
limit frame rate to 98
options for recording video 

files 102
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recording
captured image 58
configuring options 70
image file options 91
image file recording options 

91
image files 91, 95
options 69
pause 64
turn off automatically 70
video file recording options 

102
requirements 33

hardware 11
software 11

resize
pixel 144

resize window on resolution 
change 73

resolution
fix 143

resume
captured image 56

RGB
16 bits per pixel 45
2:3:3 45
24 bits per pixel 45
3:2:3 45
3:3:2 45
5:6:5 45
8 bits per pixel 45
8:8:8 format 45

RGB 16 bits per pixel 72
RGB 24 bits per pixel 45, 72
RGB 8 bits per pixel 72

S
save

captured image 57, 83
current image 62, 87
image 87
save as 62
snapshot 62, 87

save all frames
image file 94

save as
captured image 57
command 62
shortcut key 69

scaling
DirectShow 144
no resizing 144
pixel resize 144

scanners and cameras
Epiphan Frame Grabber 108

SDK
capture API 38
USB device driver 36

select device
command 64

send Ctrl-Alt-Del
command 66

serial number
Frame Grabber 121
frame grabber 55

sharing
captured images 60
changing compression 125
changing performance 125
images over the Internet 121
Internet address 124
options 69
pausing 124
starting a session 123
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SHARING OFF 124
SHARING ON 124
shortcut key 69

Ctrl+P 69
Ctrl+S 69
Ctrl+U 69
Ctrl+W 69

show
device information 88
toolbar 88

show frame count on the status 
bar 68, 74

snapshot
captured image 57, 83

software
requirements 11

software development kit
See SDK 36

software requirements
VGA2USB/ DVI2USB drivers 

and application 11
video capture workstation 11

software upgrade 53, 80
start

image file 93
video capture application 54, 

81
video file 104

start recording
command 64

status bar 56
show frame count 74
view 63

stop recording
command 64

suffix
image file 93
video file 104

T
third-party

video capture application 
107

thousands of colors 45
tiff 42
title bar 55, 82
toolbar 55, 67, 83

change button size 63, 88
command 67
display 63, 88
hide 63, 88
view menu 63, 88

Tools
menu 65

trigger
KVM 130

trigger event
KVM 87

troubleshoot 127
troubleshooting 26
true color 45
tuning capture parameters 55, 81

U
updates

checking 53, 66
upgrade

Epiphan USB device driver 
53, 80

QuickTime component 80
video capture application 53, 

80
upload

EDID 135
upload EDID 65
USB 1.1 32
USB 2.0 32
USB 2.0 ports

Mac OS X 26
Windows 26
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USB device driver 33, 36
color depth 35
Linux 43
Mac OS X 40
upgrading 53, 80
Windows 35, 76

USB port 11
user mode 34

video capture application 34
UYVY 46

V
V4L 34
VGA 48

video source 30
VGA Bridge 121
VGA Broadcaster 121
VGA information 88
VGA modes

adding custom VGA modes 
147

configuring 145
VGA2USB

connecting 17
LEDs 27
Mac OS X menu 84
maximum color depth 75
package contents 16

VGA2USB Device
connecting 16

VGA2USB HR
connecting 17
package contents 16

VGA2USB LR
connecting 17
package contents 16

VGA2USB Pro
connecting 17
package contents 16

VGA2WEB 121
video

codec 38
display options 98, 111
installing a video codec 100
options for recording video 

files 102
playing back a video file 106, 

114, 115
recording 97, 105, 113, 114
recording captured images 

105, 113, 114
recording for Linux 114
recording for Mac OS X 110
recording for Windows 97
recording for Windows Vista 

97
recording for Windows XP 97
recording from DirectShow 

109
recording using a DirectShow 

application 107
recording using VirtualDub 

107, 109
selecting a codec 98

video capture application 34, 38, 
49

DirectShow 107
Mac OS X 42
starting 54, 81
third-party 107
upgrading 53, 80
version for Mac OS X 85
VirtualDub 107
Windows 35

video capture workstation 33, 42, 
49

CPU usage high from web 
broadcasting 127

software requirements 11
USB device driver 33
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video codec
required color depth 75
supported color depth 46

video file
file name suffix 104
recording options 102
start of file name suffix 104

Video Graphics Array 48
video mode

wide 85
video resolution

recording image files on Mac 
OS X 112

video source 30
Video4Linux 34, 42, 44
View

menu 63
view

saved image files 96
VirtualDub

configuration options 110
recording a video 107

W
wait

image file 94
web broadcast

changing compression 125
changing performance 125
command 65
high CPU 127
Internet address 124
Java 124
pausing 124
problems with 127
troubleshooting 127

web broadcasting 60, 121, 124, 
127

pause 64
required color depth 75
starting a session 123

wide video mode 85
Widows

recording a video 105
window

resize 73
Windows

DirectShow 34
getting started 51
installing a video codec 100
installing the VGA2USB/

DVI2USB drivers and 
application 12

recording videos 97
selecting a video codec 98
USB 2.0 ports 26
USB device Driver 35
video capture application 35

Windows VGA2USB/DVI2USB 
drivers and application 12

Windows Vista
recording videos 97

Windows XP
recording videos 97

Y
YUY2(422) 46
ser Guide Page 165



 

P
age 166 Epiphan Frame Grabber



Software license
ATTENTION: THE SOFTWARE AND DOCUMENTATION PROVIDED UNDER THIS AGREEMENT ARE 
BEING LICENSED TO YOU BY EPIPHAN SYSTEMS INC. ("LICENSOR") AND ARE NOT BEING SOLD. 
THIS AGREEMENT CONTAINS LIMITATIONS ON REPRESENTATIONS, WARRANTIES, CONDITIONS, 
REMEDIES, AND LIABILITIES THAT ARE APPLICABLE TO THE SOFTWARE AND DOCUMENTATION.

Epiphan Systems Inc. 

Software License

IMPORTANT: BEFORE DOWNLOADING, INSTALLING, OR USING THE SOFTWARE AND 
DOCUMENTATION, PLEASE CAREFULLY READ THIS AGREEMENT WHICH CONTAINS THE 
TERMS AND CONDITIONS UNDER WHICH YOU ARE ACQUIRING A LICENSE TO USE THE 
SOFTWARE AND DOCUMENTATION. IF YOU DO NOT ACCEPT THE TERMS AND CONDITIONS OF 
THIS AGREEMENT PLEASE DO NOT DOWNLOAD, INSTALL, OR USE THE SOFTWARE AND 
DOCUMENTATION AND PROMPTLY RETURN OR DESTROY THE SOFTWARE AND 
DOCUMENTATION. IF YOU DOWNLOAD, INSTALL, OR USE THE SOFTWARE AND/OR 
DOCUMENTATION, YOU WILL HAVE ACCEPTED AND AGREED TO THESE TERMS AND 
CONDITIONS. THE SOFTWARE, HARDWARE AND DOCUMENTATION ARE ALSO PROTECTED BY 
COPYRIGHT LAWS AND INTERNATIONAL COPYRIGHT TREATIES, AS WELL AS OTHER 
INTELLECTUAL PROPERTY LAWS. IF YOU ARE AN AGENT OR EMPLOYEE OF AN ENTITY, YOU 
REPRESENT AND WARRANT THAT (I) THE INDIVIDUAL ACCEPTING THIS AGREEMENT IS DULY 
AUTHORIZED TO ACCEPT THIS AGREEMENT ON SUCH ENTITY'S BEHALF AND TO BIND SUCH 
ENTITY, AND (II) SUCH ENTITY HAS FULL POWER, CORPORATE OR OTHERWISE, TO ENTER 
INTO THIS AGREEMENT AND PERFORM ITS OBLIGATIONS UNDER THIS AGREEMENT.

1. Definitions: In this Agreement:

"Agreement" means this Epiphan Systems Inc. Software License;

"API" means an application programming interface;

"Documentation" means the technical publications delivered to You with the Software relating to the 
installation and operation of the Software and/or Hardware, such as reference, user, installation and technical 
guides and release notes;

"Epiphan" means Epiphan Systems Inc;

"Epiphan Hardware Product" means an Epiphan hardware product (including enclosure and mechanical 
parts, circuitry and electrical and electronic components contained therein) purchased by You, which is 
intended to be used in conjunction with the licensed Software and Documentation;

"License Key" means a series of computer-generated characters used for the purpose of controlling the 
operation of Epiphan Hardware Products and/or related Software;

"Software" means the Licensor binary and/or bytecode software and/or firmware programs that are (i) 
specified in Your Order or that are included with or in the Epiphan Hardware Products specified in Your Order,  
(ii) are made available to You for download after acceptance of this Agreement, (iii) are packaged with this
Agreement, (iv) pre-installed on Epiphan Hardware Products, (v) embed this Agreement in their installer(s)
and which are installed after acceptance of this Agreement, or (vi) embed this Agreement in their product
documentation.  Software also includes the related Documentation;



"You" or "Your" means the individual acquiring the Software license or any entity on whose behalf 
such individual is acting. In the case of an entity, "You" includes any entity that by majority voting 
interest controls, is controlled by, or is under common control with You; and
"Your Order" means (i) the web forms provided by Epiphan or its applicable reseller or distributor for 
ordering Epiphan Hardware Products and related Software licenses, or (ii) written documents 
executed by Epiphan, or one of its resellers or distributors, and You in respect to Your purchases of 
Epiphan Hardware Products and/or related Software licenses.

2. Grant of Software License: Subject to the terms and conditions of this Agreement, including
payment of any applicable fees specified in Your Order, Licensor grants You a non-exclusive, non-
transferable, non-sublicensable, internal license to use the number of copies of the Software
specified in Your Order and to use the Software functions specified in Your Order solely for operation
on the Epiphan Hardware Products for which such Software has been designed as specified in the
Documentation for such Software.  If the number of copies of Software is not specified in Your Order,
then the number of copies shall be a reasonable number of copies.  You acknowledge and agree that
the ability to use certain Software functions is controlled by a Licensing Key and that You will not be
able to use such functions unless You have paid the applicable fees charged by Epiphan for the right
to use such functions and to receive a Licensing Key to enable such functions.  For functions that are
controlled by a Licensing String You shall only use that Licensing String with the copy of the
Software for which it was issued and You shall not use that copy of the Licensing String with any
other copies of the Software that You may have or make. All copies of the Software made by You
shall include all trademarks, copyright notices, restricted rights legends, proprietary markings and
the like exactly as they appear on the copy of the Software originally provided to You. No other rights
in the Software or Documentation are granted to You.

3. Open Source Software: Binary, bytecode and source code versions of certain open source
software packages may be embedded in or distributed with the Software ("Open Source Software"). If
a separate license agreement for an item of open source software is: delivered to You with the
Software; included in the download package for the Software; referenced in any material (including
the Documentation) that is included in the download or distribution package for the Software; or
listed at www.epiphan.com/opensource, then such open source software shall be Open Source
Software and such separate license agreement shall govern Your use of that item or version of such
open source software. The Open Source Software may include free software (i.e. software licensed
under the GNU Lesser General Public License or other free software licenses) for which the
applicable free software license may also require that the source code for such free software be
made available to those receiving only executable versions of such free software. If the source code
for any free software distributed with the Software is not provided with the Software, then upon
request, within a three (3) year period from the original receipt of the binary or bytecode version of
such Open Source Software from Licensor, for a fee that shall not exceed Licensor's costs
associated with the shipping of the source code for such free software, Licensor will provide a copy
of the source code for such free software to You.



4. Restrictions: The terms set forth in this Section 4 are additional conditions to the licenses granted in Section
2. Your right to use the Software is conditioned upon Your timely payment of the full amount of fees due for: (i)
the Epiphan Hardware Product(s) on which You want to use the Software; (ii) all support agreements You have
entered into with Licensor or any of its distributors and/or resellers; (iii) licensed Software and Documentation.
You shall not reverse engineer, disassemble, reverse translate, decompile or in any other manner decode any
Epiphan Hardware Product or Software except to the extent the Software is distributed with any Open Source
Software that prohibits the imposition of such a restriction or to the extent the foregoing restriction is expressly
prohibited by applicable law notwithstanding a contractual obligation to the contrary. You acknowledge and
agree that no rights in respect to the source code of the Software are granted to You. You acknowledge and
agree that the rights in respect to use of the Software and Documentation are granted only for use in
conjunction with Epiphan Hardware Products. You shall not distribute, lease, rent, grant a security interest in,
assign, or otherwise transfer the Software except as expressly provided in this Agreement. You shall not modify
or create any derivatives works of the Software or merge all or any part of the Software with another program.
Notwithstanding the foregoing, You may call public APIs made available by Epiphan in the Software from
applications developed by or on Your behalf provided that such applications do not embed any of the Software
other than the minimum linkage materials required to call separately running instances of the Software. You
shall not use the Software or make the Software available to any third parties as part of any service bureau,
time sharing service, application service provider offering, software-as-a-service offering or any other managed
service offering. You shall not disclose any performance, benchmarking, or feature-related information about
the Software. You further agree not to disclose, transfer or otherwise provide to any third party any portion of
the Software, except as expressly permitted herein.

Some Epiphan Hardware Products and Software embed third-party APIs that integrate with third-party party 
services (“Third-Party Services”) to allow users of such Epiphan Hardware Products and Software to interact 
with such Third-Party Services for various capabilities offered by such Third-Party Services, such as, and 
without limitation, authentication, uploading and downloading of video content and other features made 
available by such Third-Party Services. If You access or use any Third-Party Service and/or related APIs using 
an Epiphan Hardware Product and/or the Software then You shall comply with all of the terms and conditions 
for such Third-Party Service and/or related APIs.

5. Disclaimer of Warranties: EXCEPT FOR ANY WARRANTIES THAT MAY BE PROVIDED IN ANY
COMMERCIAL AGREEMENT EXECUTED BETWEEN YOU AND LICENSOR (OR BETWEEN YOU AND
ONE OF LICENSOR’S RESELLERS OR DISTRIBUTORS), THE EPIPHAN HARDWARE PRODUCTS,
SOFTWARE AND/OR DOCUMENTATION ARE PROVIDED “AS IS”, WITHOUT ANY REPRESENTATIONS,
CONDITIONS, AND/OR WARRANTIES OF ANY KIND. WITHOUT LIMITATION, LICENSOR AND ITS
AFFILIATES AND ITS AND THEIR LICENSORS, SUPPLIERS, SUBCONTRACTORS, RESELLERS AND
DISTRIBUTORS DISCLAIM ANY AND ALL IMPLIED REPRESENTATIONS, CONDITIONS AND/OR
WARRANTIES OF MERCHANTABILITY, MERCHANTABLE QUALITY, NON-INFRINGEMENT,
DURABILITY, COMPATIBILITY, TITLE, SATISFACTORY QUALITY AND/OR FITNESS FOR A
PARTICULAR PURPOSE WHETHER ARISING BY STATUTE, COURSE OF DEALING, USAGE OF TRADE
OR OTHERWISE. EXCEPT AS OTHERWISE EXPRESSLY PROVIDED IN ANY COMMERCIAL
AGREEMENT EXECUTED BETWEEN YOU AND LICENSOR (OR BETWEEN YOU AND ONE OF
LICENSOR’S RESELLERS OR DISTRIBUTORS), THE ENTIRE RISK OF THE USE OF THE EPIPHAN
HARDWARE PRODUCTS, SOFTWARE AND/OR DOCUMENTATION SHALL BE BORNE BY YOU.
EXCEPT AS OTHERWISE EXPRESSLY PROVIDED IN ANY COMMERCIAL AGREEMENT EXECUTED
BETWEEN YOU AND LICENSOR (OR BETWEEN YOU AND ONE OF LICENSOR’S RESELLERS OR



 DISTRIBUTORS), NEITHER LICENSOR NOR ANY OF ITS AFFILIATES NOR ANY OF ITS OR THEIR 
LICENSORS, SUPPLIERS, SUBCONTRACTORS, RESELLERS AND/OR DISTRIBUTORS MAKE ANY 
REPRESENTATIONS OR PROVIDE ANY CONDITIONS AND/OR WARRANTIES ABOUT THE 
SUITABILITY OF THE EPIPHAN HARDWARE PRODUCTS, SOFTWARE, SERVICES AND/OR 
DOCUMENTATION. NEITHER LICENSOR NOR ANY OF ITS AFFILIATES NOR ANY ITS OR THEIR 
LICENSORS, SUPPLIERS, SUBCONTRACTORS, RESELLERS AND/OR DISTRIBUTORS MAKE ANY 
REPRESENTATIONS OR PROVIDE ANY CONDITIONS AND/OR WARRANTIES WHATSOEVER ABOUT 
ANY INFORMATION AND/OR DATA THAT MAY BE PROCESSED BY OR MADE AVAILABLE USING 
ANY EPIPHAN HARDWARE PRODUCT AND/OR SOFTWARE OR ABOUT ANY THIRD-PARTY SERVICE 
THAT MAY BE ACCESSIBLE USING ANY EPIPHAN HARDWARE PRODUCT AND/OR SOFTWARE.

6. LIMITATION OF LIABILITY: NEITHER LICENSOR NOR ANY OF ITS AFFILIATES NOR ANY OF ITS 
OR THEIR LICENSORS, SUPPLIERS, SUBCONTRACTORS, RESELLERS AND/OR DISTRIBUTORS 
SHALL HAVE ANY LIABILITY TO YOU OR ANY OTHER PERSON OR ENTITY FOR ANY DAMAGES 
ARISING FROM THIS AGREEMENT, RELATING TO THE HARDWARE,  SOFTWARE OR 
DOCUMENTATION, OR RELATING TO ANY SERVICES PROVIDED TO YOU BY LICENSOR 
(INCLUDING ITS AFFILIATES AND ITS AND THEIR LICENSORS, SUPPLIERS, SUBCONTRACTORS, 
RESELLERS AND/OR DISTRIBUTORS) IN RELATION TO THE EPIPHAN HARDWARE PRODUCTS, 
SERVICES, SOFTWARE AND/OR DOCUMENTATION FOR ANY INDIRECT, RELIANCE, INCIDENTAL, 
SPECIAL, PUNITIVE, EXEMPLARY OR CONSEQUENTIAL DAMAGES, INCLUDING, BUT NOT LIMITED 
TO, LOSS OF REVENUE OR PROFIT, LOSS OF OR DAMAGE TO DATA, BUSINESS INTERRUPTION, 
LOSS OF DATA, REPLACEMENT OR RECOVERY COSTS, OR OTHER COMMERCIAL OR ECONOMIC 
LOSS, WHETHER ARISING FROM CONTRACT, EQUITY, TORT (INCLUDING NEGLIGENCE OR STRICT 
LIABILITY) OR ANY OTHER THEORY OF LIABILITY, EVEN IF LICENSOR (INCLUDING ITS AFFILIATES 
AND ITS AND THEIR LICENSORS, SUPPLIERS, SUBCONTRACTORS, RESELLERS AND/OR 
DISTRIBUTORS) HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, OR THEY ARE 
FORESEEABLE. THE LIMITATIONS IN THIS SECTION SHALL APPLY WHETHER OR NOT THE 
ALLEGED BREACH OR DEFAULT IS A BREACH OF A FUNDAMENTAL CONDITION OR TERM OR 
FUNDAMENTAL BREACH. SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION 
OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, SO THESE LIMITATIONS MAY NOT 
APPLY TO YOU. IN NO EVENT SHALL THE TOTAL CUMULATIVE LIABILITY OF LICENSOR 
(INCLUDING ITS AFFILIATES AND ITS AND THEIR LICENSORS, SUPPLIERS, SUBCONTRACTORS, 
RESELLERS AND DISTRIBUTORS) TO YOU OR ANY OTHER PERSON OR ENTITY FOR ANY 
DAMAGES ARISING FROM THIS AGREEMENT, RELATING TO THE EPIPHAN HARDWARE 
PRODUCTS, SOFTWARE, DOCUMENTATION AND/OR RELATING TO ANY SERVICES PROVIDED TO 
YOU BY LICENSOR (INCLUDING ITS AFFILIATES AND ITS AND THEIR LICENSORS, SUPPLIERS, 
SUBCONTRACTORS, RESELLERS AND DISTRIBUTORS) IN RELATION TO THE EPIPHAN 
HARDWARE PRODUCTS, SOFTWARE AND/OR DOCUMENTATION, EXCEED THE LICENSE FEES 
PAID BY YOU FOR THE SOFTWARE.

THE DISCLAIMER OF REPRESENTATIONS, WARRANTIES AND CONDITIONS AND LIMITATION OF 
LIABILITY CONSTITUTE AN ESSENTIAL PART OF THIS AGREEMENT. YOU ACKNOWLEDGE THAT 
BUT FOR THE DISCLAIMER OF REPRESENTATIONS, WARRANTIES AND CONDITIONS AND 
LIMITATION OF LIABILITY, NEITHER LICENSOR NOR ANY OF ITS AFFILIATES OR ITS OR THEIR 
LICENSORS, SUPPLIERS, RESELLERS OR DISTRIBUTORS WOULD GRANT THE RIGHTS GRANTED 
IN THIS AGREEMENT.



7. Term and Termination: This Agreement shall continue for as long as You use the Software, however, it
may be terminated sooner as provided in this Section 7. You may terminate this Agreement by destroying all
copies of the Software and Documentation under Your control and providing certification of such destruction
to Licensor or by returning the Software to Licensor. Licensor may terminate this Agreement immediately by
providing You with written notice if: (a) You are in material breach of any provision of this Agreement, which
breach, if capable of being cured, is not cured within thirty (30) days after Licensor gives You written notice
thereof; or (b) You have committed a non-curable material breach of this Agreement. Upon termination You
shall destroy all copies of the Software and Documentation. In addition to this Section, the Sections entitled
Definitions, Disclaimer of Warranties, Limitation of Liability, Title, Indemnities, High-Risk Activities, Intellectual
Property, and General shall continue in force even after any termination of this Agreement. No termination of
this Agreement will entitle You to a refund of any amounts paid by You to Licensor or any reseller or
distributor or affect any obligations You may have to pay any outstanding amounts owing to Licensor or any
reseller or distributor. Upon any termination of this Agreement, Your license to the Software and
Documentation will terminate and You shall destroy all copies of the Software and Documentation under Your
control and certify such destruction to Licensor.

8. Support and Updates: This Agreement does not grant You the right to any updates or enhancements of
the Software or the right to receive any technical support for the Software. Such updates and other technical
support services, if available, may be purchased separately from Licensor or one of Licensor’s resellers or
distributors. Use of any updates or enhancements to the Software provided pursuant to any technical support
You may procure from Licensor or one of Licensor’s resellers or distributors shall be governed by the terms
and conditions of this Agreement. Licensor reserves the right at any time not to release or to discontinue the
release of any Software and to alter prices, features, specifications, capabilities, functions, licensing terms,
release dates, general availability or other characteristics of the Software.

9. Title: All right, title, and interest (including all intellectual property rights) in, to, and under the Software
(including all copies thereof) shall remain with Licensor and its licensors.

10. Indemnities: You shall indemnify, defend and hold Licensor, its affiliates, its and their licensors, suppliers,
subcontractors, resellers and/or distributors and all of the directors, officers, employees of all of the foregoing
(collectively the “Indemnified Parties”) harmless from and against any damages, losses, liabilities, expenses,
costs, claims, demands, actions, suits and/or proceedings incurred by the Indemnified Parties as a result of (i)
Your use of the Epiphan Hardware Products, Software and/or Documentation, (ii) any use of the Epiphan
Hardware Products, Software and/or Documentation on Your behalf, (iii) the use of the Epiphan Hardware
Products, Software and/or Documentation by anyone to whom You give the Epiphan Hardware Products,
Software and/or Documentation, and/or (iv) the use of the Epiphan Hardware Products, Software and/or
Documentation on behalf of anyone to whom You give the Epiphan Hardware Products, Software and/or
Documentation, including, without limitation, in all of the foregoing cases, any damages, losses, liabilities,
expenses, costs, claims, demands, actions, suits and/or proceedings arising from or relating to any
information and/or data that may be processed by or made available using any Epiphan Hardware Product
and/or Software or arising from or relating to any Third-Party Service that may be accessible using any
Epiphan Hardware Product and/or Software (collectively, each matter falling within any of the foregoing, a
“Claim”), including, without limitation, indemnifying, defending and holding the Indemnified Parties



7. Term and Termination: This Agreement shall continue for as long as You use the Software, however, it
may be terminated sooner as provided in this Section 7. You may terminate this Agreement by destroying all
copies of the Software and Documentation under Your control and providing certification of such destruction
to Licensor or by returning the Software to Licensor. Licensor may terminate this Agreement immediately by
providing You with written notice if: (a) You are in material breach of any provision of this Agreement, which
breach, if capable of being cured, is not cured within thirty (30) days after Licensor gives You written notice
thereof; or (b) You have committed a non-curable material breach of this Agreement. Upon termination You
shall destroy all copies of the Software and Documentation. In addition to this Section, the Sections entitled
Definitions, Disclaimer of Warranties, Limitation of Liability, Title, Indemnities, High-Risk Activities, Intellectual
Property, and General shall continue in force even after any termination of this Agreement. No termination of
this Agreement will entitle You to a refund of any amounts paid by You to Licensor or any reseller or
distributor or affect any obligations You may have to pay any outstanding amounts owing to Licensor or any
reseller or distributor. Upon any termination of this Agreement, Your license to the Software and
Documentation will terminate and You shall destroy all copies of the Software and Documentation under Your
control and certify such destruction to Licensor.

8. Support and Updates: This Agreement does not grant You the right to any updates or enhancements of
the Software or the right to receive any technical support for the Software. Such updates and other technical
support services, if available, may be purchased separately from Licensor or one of Licensor’s resellers or
distributors. Use of any updates or enhancements to the Software provided pursuant to any technical support
You may procure from Licensor or one of Licensor’s resellers or distributors shall be governed by the terms
and conditions of this Agreement. Licensor reserves the right at any time not to release or to discontinue the
release of any Software and to alter prices, features, specifications, capabilities, functions, licensing terms,
release dates, general availability or other characteristics of the Software.

9. Title: All right, title, and interest (including all intellectual property rights) in, to, and under the Software
(including all copies thereof) shall remain with Licensor and its licensors.

10. Indemnities: You shall indemnify, defend and hold Licensor, its affiliates, its and their licensors, suppliers,
subcontractors, resellers and/or distributors and all of the directors, officers, employees of all of the foregoing
(collectively the “Indemnified Parties”) harmless from and against any damages, losses, liabilities, expenses,
costs, claims, demands, actions, suits and/or proceedings incurred by the Indemnified Parties as a result of (i)
Your use of the Epiphan Hardware Products, Software and/or Documentation, (ii) any use of the Epiphan
Hardware Products, Software and/or Documentation on Your behalf, (iii) the use of the Epiphan Hardware
Products, Software and/or Documentation by anyone to whom You give the Epiphan Hardware Products,
Software and/or Documentation, and/or (iv) the use of the Epiphan Hardware Products, Software and/or
Documentation on behalf of anyone to whom You give the Epiphan Hardware Products, Software and/or
Documentation, including, without limitation, in all of the foregoing cases, any damages, losses, liabilities,
expenses, costs, claims, demands, actions, suits and/or proceedings arising from or relating to any
information and/or data that may be processed by or made available using any Epiphan Hardware Product
and/or Software or arising from or relating to any Third-Party Service that may be accessible using any
Epiphan Hardware Product and/or Software (collectively, each matter falling within any of the foregoing, a
“Claim”), including, without limitation, indemnifying, defending and holding the Indemnified Parties harmless
from and against any settlements agreed by You in connection with any Claims and/or any damages,



costs or other amounts (including reasonable attorneys' fees) awarded to a third party against any of the 
Indemnified Parties by a court or tribunal of competent jurisdiction in respect to any Claim.  If You do not 
timely defend against or resist a Claim after notice from Licensor, Licensor shall be entitled to investigate, 
defend, compromise, settle, or otherwise dispose of the Claim, and incur costs in connection therewith, at 
Your expense, in such manner as Licensor deems in its best interests until a reasonable time after You 
comply with its obligations under this Section 10.  You shall not enter into a settlement of any Claim without 
the Licensor’s written consent unless such settlement is solely for monetary payment by You and contains an 
express, complete, unconditional release of all of the Indemnified Parties and which does not impose any 
obligations or restrictions on any of the Indemnified Parties.

11. High-Risk Activities: The Software and Epiphan Hardware Products are not fault-tolerant and are not
designed, manufactured or intended for use in or in conjunction with on-line control equipment in hazardous
environments requiring fail-safe performance, such as in the operation of nuclear facilities, aircraft navigation
systems, air traffic control, or direct life support machines. Licensor, its licensors, suppliers, subcontractors,
resellers and distributors specifically disclaim any express or implied representations, warranties and/or
conditions for such uses.

12. U.S. Government End-Users: The Software and Documentation are each a "commercial item" as that
term is defined at FAR 2.101, consisting of "commercial computer software" and "commercial computer
software documentation" as such terms are defined in FAR 12.212, and are provided to the U.S. Government
only as commercial end items. Government end users acquire the rights set out in this Agreement for the
Software, Epiphan Hardware Products and Documentation consistent with: (i) for acquisition by or on behalf of
civilian agencies, the terms set forth in FAR12.212; or (ii) for acquisition by or on behalf of units of the
Department of Defense, the terms set forth in DFARS 227.7202. Use of the Epiphan Hardware Products,
Software and Documentation is further restricted by the terms and conditions of this Agreement and the
applicable commercial purchase agreement for the Epiphan Hardware Products. For the purposes of any
applicable government use, the Epiphan Hardware Products, Software and Documentation were developed
exclusively at private expense, and are trade secrets of Epiphan Systems Inc. for the purpose of any Freedom
of Information legislation or any other disclosure statute, regulation or provision.

13. Export Restrictions: The Epiphan Hardware Products, Software, Documentation and related information
are subject to export and import restrictions. By downloading, installing, or using the Software, Epiphan
Hardware Products, Documentation and/or related information, You are representing and warranting that You
are not located in, are not under the control of, and are not a national or resident of any country to which the
export of the Epiphan Hardware Products, Software, Documentation and/or related information would be
prohibited by the laws and/or regulations of Canada or the United States. You are also representing and
warranting that You are not an individual to whom the export of the Epiphan Hardware Products, Software,
Documentation or related information would be prohibited by the laws and/or regulations of Canada or the
United States. You shall comply with the export laws and regulations of Canada and the United States that are
applicable to the Epiphan Hardware Products, Software, Documentation and related information and You shall
also comply with any local laws and/or regulations in Your jurisdiction that may impact Your right to export,
import, or use the Epiphan Hardware Products, Software, Documentation or related information, and You
represent and warrant that You have complied with any such applicable laws and/or regulations. The Epiphan
Hardware Products, Software, Documentation and related information shall not be used for any purposes
prohibited by export laws and/or regulations, including, without limitation, nuclear, chemical, or biological
weapons proliferation. You shall be responsible for procuring all required permissions for any subsequent
export, import, or use of the Epiphan Hardware Products, Software, Documentation or related information.



14. Intellectual Property: Epiphan, Epiphan Systems and Epiphan Video are tradenames, trademarks or
registered trademarks of Epiphan Systems Inc. in certain countries. All Licensor product names and logos are
trademarks or registered trademarks of Epiphan Systems Inc. in certain countries. All other company and
product names and logos are trademarks or registered trademarks of their respective owners in certain
countries. You shall not disclose, transfer or otherwise provide to any third party any portion of the Software,
except as expressly permitted in this Agreement.

15. General: This Agreement is the entire agreement between You and Licensor in respect to the Software,
superseding any other agreements or discussions, oral or written. The terms and conditions of this Agreement
shall prevail over any pre-printed terms on any quotes, orders, purchase orders, or purchase order
acknowledgements, and shall prevail over any other communications between the parties in relation to the
Software. You may not assign this Agreement whether voluntarily, by operation of law, or otherwise without
Licensor's prior written consent. Licensor may assign this Agreement at any time without notice. The failure of
a party to claim a breach of any term of this Agreement shall not constitute a waiver of such breach or the right
of such party to enforce any subsequent breach of such term. If any provision of this Agreement is held to be
unenforceable or illegal, such decision shall not affect the validity or enforceability of such provisions under
other circumstances or the remaining provisions of this Agreement and such remaining provisions shall be
reformed only to the extent necessary to make them enforceable under such circumstances. This Agreement
shall be governed by the laws of the Province of Ontario and the laws of Canada applicable therein. No choice
or conflict of laws rules of any jurisdiction shall apply to this Agreement. You shall only be entitled to bring any
action or proceeding arising out of or relating to this Agreement, the Epiphan Hardware Products, Software,
Documentation or any services provided in respect to the Epiphan Hardware Products, Software and/or
Documentation in a court in Ottawa, Ontario, Canada, and You consent to the jurisdiction of such courts for
any such action or proceeding. You waive all rights that You may have or that may hereafter arise to contest
the jurisdiction of such courts for any action or proceeding brought by You. You hereby waive any right You
may have to request a jury trial with respect to any action brought by You in connection with this Agreement,
the Epiphan Hardware Products or Software or any services provided in respect to the Epiphan Hardware
Products or Software. The application of the United Nations Convention on Contracts for the International Sale
of Goods to this Agreement is expressly excluded.

October 6, 2016
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Environmental Information

The equipment that you bought has required the extract ion and use of natural resources for its product ion. It 
may contain hazardous substances that could impact health and the environment. In order to avoid the 
disseminat ion of those substances in our environment and to diminish the pressure on the natural resources, 
we encourage you to use the appropriate take-back systems. Those systems will reuse or recycle most of the 
materials of your end life equipment in a sound way. The crossed-out wheeled bin symbol invites you to use 
those systems. If you need more information about collect ion, reuse and recycling systems, please contact your 
local or regional waste administrat ion. You can also contact us for more information on the environmental 
performance of our products.

Important Safety Warnings

WARNING: This product has no user-serviceable parts and the battery used in this device is not replaceable. Do 
not attempt to disassemble. Return the device for service.

CAUTION, RISK OF ELECTRICSHOCK: This device may have mult iple ACpower cords installed. All power sources 
shall be disconnected before servicing to avoid shock hazard.

ATTENTION: Cet appareil ne cont ient aucun composant pouvant être entretenu ou réparé par l'ut ilisateur. En 
cas de panne, retourner l'appareil pour réparat ion.

ATTENTION, RISQUEDECHOCÉLECTRIQUE: Cet appareil peut être équipé de mult iples cordons

d'alimentat ion en courant alternat if . Pour placer cet appareil hors tension, débrancher tous les cordons

d'alimentat ion sans except ion.

FCC & CE Compliance Statement

This device complies with Part 15 of the FCCRules. Operat ion is subject to the following two condit ions:

1. This device may not cause harmful interference

2. This device must accept any interference received, including interference that may cause undesired

operat ion.

Marking by the symbol indicates compliance of this device with EMCdirect ive of the European Community

and meets or exceeds the following technical standard.

EN 55022 - Limits and Methods of Measurement of Radio Interference Characterist ics of Information

Technology Equipment.



Other Jurisdict ional Issues

Epiphan makes no representat ion that its products or information in this document or its web site is appropriate 
or available for use in your jurisdict ion. Those who choose to access the Epiphan web site or use Epiphan 
products do so on their own init iat ive and are responsible for compliance with local laws, if and to the extent 
local laws are applicable

Submissions to Epiphan and Affiliated Servers

Any information, including but not limited to remarks, suggest ions, ideas, graphics, or other submissions, 
communicated to Epiphan through their Epiphan web site is the exclusive property of Epiphan. Epiphan is 
ent it led to use any information submit ted for any purpose, without restrict ion (except as stated in Epiphan's 
Privacy Statement) or compensat ion to the person sending the submission. The user acknowledges the 
originality of any submission communicated to Epiphan and accepts responsibility for its accuracy, 
appropriateness, and legality.

Third Part ies and Links to Third-Party Web Sites

Mention of non-Epiphan Systems Inc. products or services on their website, or this document site is for 
informational purposes and does not const itute an endorsement or recommendat ion.

This document may contain links to non-Epiphan web sites. These links are provided to you as a convenience, 
and Epiphan is not responsible for the content of any linked web site. Any outside web site accessed f rom the 
Epiphan web site is independent f rom Epiphan, and Epiphan has no control over the content of that web site. In 
addit ion, a link to any non-Epiphan web site does not imply that Epiphan endorses or accepts any responsibility 
for the content or use of such a web site.

In no event shall any reference to any third party or third party product or service be construed as an approval 
or endorsement by Epiphan of that third party or of any product or service provided by a third party.

Miscellaneous
It is the user's responsibility to ascertain whether any information downloaded from the Epiphan web site or 
other websites is free of viruses, worms, trojan horses, or other items of a potentially destructive nature.
Enforcement of Terms and Conditions
These Terms and Conditions for use of this document and the associated Epiphan Product are governed and 
interpreted pursuant to the laws of the province of Ontario, Canada, notwithstanding any principles of
conflicts of law.

All disputes arising out of or relating to these Terms and Conditions shall be finally resolved by arbitration 
conducted in the English language in Ottawa, Ontario, Canada under the commercial arbitration rules of the 
Canada. The parties shall appoint as sole arbitrator a retired judge who presided in the province of Ontario. The 
parties shall bear equally the cost of the arbitration (except that the prevailing party shall be entitled to an award 
of reasonable attorneys' fees incurred in connection with the arbitration in such an amount as may be 
determined by the arbitrator). All decisions of the arbitrator shall be final and binding on both parties and 
enforceable in any court of competent jurisdiction. Notwithstanding this, application may be made to any court 
for a judicial acceptance of the award or order of enforcement. Notwithstanding the foregoing, Epiphan shall be 
entitled to seek injunctive relief, security, or other equitable remedies from any court of competent jurisdiction.



If any part of these terms is unlawful, void, or unenforceable, that part will be deemed severable and will not 
affect the validity and enforceability of the remaining provisions. Epiphan may, at its sole discret ion and without 
not ice, revise these terms at any t ime by updat ing this post ing.

Copyright © 2016 Epiphan Systems Inc.

All Rights Reserved.
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